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Overview

Feather is the new development board from Adafruit, and like it's namesake it is thin,
light, and lets you fly! We designed Feather to be a new standard for portable
microcontroller cores.

This is the Adafruit Feather MO Bluefruit - our take on an 'all-in-one' Cortex MO+
Arduino-compatible + Bluetooth Low Energy with built in USB and battery charging. Its
an Adafruit Feather MO with a BTLE module, ready to rock! We have other boards in

the Feather family, check'em out here ()

Bluetooth Low Energy is the hottest new low-power, 2.4GHz spectrum wireless
protocol. In particular, its the only wireless protocol that you can use with iOS without
needing special certification and it's supported by all modern smart phones. This
makes it excellent for use in portable projects that will make use of an iOS or Android
phone or tablet. It also is supported in Mac OS X and Windows 8+

At the Feather MO's heart is an ATSAMD21G18 ARM Cortex MO processor, clocked at
48 MHz and at 3.3V logic, the same one used in the new Arduino Zero (http://
adafru.it/2843). This chip has a whopping 256K of FLASH (8x more than the
Atmega328 or 32u4) and 32K of RAM (16x as much)! This chip comes with built in USB
so it has USB-to-Serial program & debug capability built in with no need for an FTDI-
like chip.
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To make it easy to use for portable projects, we added a connector for any of our 3.7V
Lithium polymer batteries and built in battery charging. You don't need a battery, it will
run just fine straight from the micro USB connector. But, if you do have a battery, you
can take it on the go, then plug in the USB to recharge. The Feather will automatically
switch over to USB power when its available. We also tied the battery thru a divider to
an analog pin, so you can measure and monitor the battery voltage to detect when
you need a recharge.
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Here's some handy specs! Like all Feather MO's you get:

« Measures 2.0" x 0.9" x 0.28" (51mm x 23mm x 8mm) without headers soldered in
. Light as a (large?) feather - 5.7 grams

« ATSAMD21G18 @ 48MHz with 3.3V logic/power

« 256KB of FLASH + 32KB of RAM
+ No EEPROM

« 3.3V regulator with 500mA peak current output

« USB native support, comes with USB bootloader and serial port debugging
« You also get tons of pins - 20 GPIO pins
- Hardware Serial, hardware 12C, hardware SPI support
+ 8 x PWM pins

« 10 x analog inputs

« Built in 100mA lipoly charger with charging status indicator LED

« Pin #13 red LED for general purpose blinking

- Power/enable pin
+ 4 mounting holes
» Reset button
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The Feather MO Bluefruit uses the extra space left over to add our excellent Bluefruit
BTLE module + two status indicator LEDs
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The Power of Bluefruit LE

The Bluefruit LE module is an nRF51822 chipset from Nordic, programmed with multi-
function code that can do quite a lot! For most people, they'll be very happy to use
the standard Nordic UART RX/TX connection profile. In this profile, the Bluefruit acts
as a data pipe, that can 'transparently' transmit back and forth from your iOS or
Android device. You can use our iOS App () or Android App (), or write your own to
communicate with the UART service ().

The board is capable of much more than just sending strings over the airl Thanks to
an easy to learn AT command set (), you have full control over how the device

behaves, including the ability to define and manipulate your own GATT Services and
Characteristics (), or change the way that the device advertises itself for other
Bluetooth Low Energy devices to see. You can also use the AT commands to query

the die temperature, check the battery voltage, and more, check the connection RSSI
or MAC address, and tons more. Really, way too long to list here!

Use the Bluefruit App to get your project started

Using our Bluefruit iOS App () or Android App (), you can quickly get your project
prototyped by using your iOS or Android phone/tablet as a controller. We have a color
picker (), quaternion/accelerometer/gyro/magnetometer or location (GPS) (), and an 8-
button control game pad (). This data can be read over BLE and piped into the
ATSAMD chip for processing & control
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You can do a lot more too!

« The Bluefruit can also act like an HID Keyboard () (for devices that support BLE

HID)

« Can become a BLE Heart Rate Monitor () (a standard profile for BLE) - you just

need to add the pulse-detection circuitry
« Turn it into a UriBeacon (), the Google standard for Bluetooth LE beacons. Just

power it and the 'Friend will bleep out a URL to any nearby devices with the

UriBeacon app installed.
« Built in over-the-air bootloading capability so we can keep you updated with the

hottest new firmware (). Use any Android or iOS device to get updates and

install them. This will update the native code on the BLE module, to add new
wireless capabilities, not program the ATmega chip.

Comes fully assembled and tested, with a USB bootloader that lets you quickly use it
with the Arduino IDE. We also toss in some header so you can solder it in and plug
into a solderless breadboard. Lipoly battery, breadboard and USB cable not included (
but we do have lots of options in the shop if you'd like!)

Pinouts
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Click here to view a PDF version of the pinout diagram ()

The Feather MO Bluefruit is chock-full of microcontroller goodness. There's also a lot
of pins and ports. We'll take you a tour of them now!
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« GND - this is the common ground for all power and logic
« BAT - this is the positive voltage to/from the JST jack for the optional Lipoly

battery
« USB - this is the positive voltage to/from the micro USB jack if connected
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« EN - this is the 3.3V regulator's enable pin. It's pulled up, so connect to ground
to disable the 3.3V regulator
« 3V - this is the output from the 3.3V regulator, it can supply 500mA peak

Logic pins

This is the general purpose I/O pin set for the microcontroller.
All logic is 3.3V

Nearly all pins can do PWM output

All pins can be interrupt inputs

« #0 / RX - GPIO #0, also receive (input) pin for Seriall (hardware UART), also can
be analog input

« #1/ TX - GPIO #1, also transmit (output) pin for Seriall, also can be analog input

« #20 / SDA - GPIO #20, also the 12C (Wire) data pin. There's no pull up on this pin
by default so when using with 12C, you may need a 2.2K-10K pullup.

« #21/ SCL - GPIO #21, also the 12C (Wire) clock pin. There's no pull up on this pin
by default so when using with 12C, you may need a 2.2K-10K pullup.

« #5 - GPIO #5

« #6 - GPIO #6

« #9 - GPIO #9, also analog input A7. This analog input is connected to a voltage
divider for the lipoly battery so be aware that this pin naturally 'sits' at around
2VDC due to the resistor divider

« #10 - GPIO #10

« #11 - GPIO #11

« #12 - GPIO #12

- #13 - GPIO #13 and is connected to the red LED next to the USB jack

« AO - This pin is analog input AO but is also an analog output due to having a
DAC (digital-to-analog converter). You can set the raw voltage to anything from O
to 3.3V, unlike PWM outputs this is a true analog output

« Althru A5 - These are each analog input as well as digital I/0 pins.

« SCK/MOSI/MISO (GPIO 24/23/22)- These are the hardware SPI pins, you can use
them as everyday GPIO pins (but recommend keeping them free as they are
best used for hardware SPI connections for high speed and are shared with the
BLE)
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Bluefruit LE Module + Indicator LEDs

Since not all pins can be brought out to breakouts, due to the small size of the
Feather, we use these to control the BLE module

« #8 - used as the Bluefruit CS (chip select) pin
« #7 - used as the Bluefruit IRQ (interrupt request) pin.
« #4 - used as the Bluefruit Reset pin

Since these are not brought out there should be no risk of using them by accident!

Other Pins!

« RST - this is the Reset pin, tie to ground to manually reset the ATSAMD, as well
as launch the bootloader manually

- ARef - the analog reference pin. Normally the reference voltage is the same as
the chip logic voltage (3.3V) but if you need an alternative analog reference,
connect it to this pin and select the external AREF in your firmware. Can't go
higher than 3.3V!

« DFU - this is the force-DFU (device firmware upgrade) pin for over-the-air
updates to the Bluefruit module. You probably don't need to use this but its
available if you need to upgrade! Check out the DFU Bluefruit Upgrades page
for how to use it. Otherwise, keep it disconnected.
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SWD Pins

There's two sets of SWD pins. These are used for program/debug of the two
processors on the Feather.
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The round pads on the right are for the ATSAMD21G18 (main processor). The
rectangular pads to the left are for the nrf51822 inside the BLE module.

You cannot connect these together to debug both at the same time!

Factory Reset

The (somewhat deceptively labeled) 'Reset' pad on the bottom of the PCB beside
SWCLK and SWDIO is for Factory Reset. Connecting this pad to GND at startup will
perform a factory reset, erasing any config settings and may be useful trying to
recover a device in a faulty state. Be sure to remove the connection to GND after the
first power cycle.
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Assembly

We ship Feathers fully tested but without headers attached - this gives you the most
flexibility on choosing how to use and configure your Feather

Header Options!

Before you go gung-ho on soldering, there's a few options to consider!

The first option is soldering in plain male
headers, this lets you plug in the Feather
ﬂ ﬂ ﬂ u ﬂ “ ﬂ ﬂ H ﬂ l ﬂ ﬂ [I ﬂ ! into a solderless breadboard

HHHMHHH(IIIIII‘M
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Another option is to go with socket female
headers. This won't let you plug the
Feather into a breadboard but it will let
you attach featherwings very easily

A few Feather boards require access to
top-side components like buttons or
connectors, making stacking impractical.
Sometimes you can stack in the opposite
order—FeatherWing underneath—or, if
both Feather and Wing require top-side
access, place the boards side-by-side with
a FeatherWing Doubler () or Tripler ().
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We also have 'slim' versions of the female

headers, that are a little shorter and give a
more compact shape
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Finally, there's the "Stacking Header"
option. This one is sort of the best-of-both-
worlds. You get the ability to plug into a
solderless breadboard and plug a
featherwing on top. But its a little bulky

Soldering in Plain Headers
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Add the breakout board:

Place the breakout board over the pins so
that the short pins poke through the
breakout pads

And Solder!

Be sure to solder all pins for reliable
electrical contact.

(For tips on soldering, be sure to check out
our Guide to Excellent Soldering ()).
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Solder the other strip as well.
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You're done! Check your solder joints
visually and continue onto the next steps

Tape In Place
For sockets you'll want to tape them in

place so when you flip over the board they
don't fall out
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Flip & Tack Solder

After flipping over, solder one or two
' : : points on each strip, to 'tack' the header in
featlier .~ place
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And Solder!

Be sure to solder all pins for reliable
electrical contact.

(For tips on soldering, be sure to check out
our Guide to Excellent Soldering ()).
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You're done! Check your solder joints
visually and continue onto the next steps
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Battery + USB Power

We wanted to make our Feather boards easy to power both when connected to a
computer as well as via battery.

There's two ways to power a Feather:

1. You can connect with a USB cable (just plug into the jack) and the Feather will
regulate the 5V USB down to 3.3V.

2. You can also connect a 4.2/3.7V Lithium Polymer (LiPo/LiPoly) or Lithium lon
(Lilon) battery to the JST jack. This will let the Feather run on a rechargeable
battery.

When the USB power is powered, it will automatically switch over to USB for power,
as well as start charging the battery (if attached). This happens 'hot-swap' style so you
can always keep the LiPoly connected as a 'backup' power that will only get used
when USB power is lost.

T

Q0000
’?{ﬁ: by NG
| cFeather 1@ -

The above shows the Micro USB jack (left), LiPoly JST jack (top left), as well as the
3.3V regulator and changeover diode (just to the right of the JST jack) and the LiPoly
charging circuitry (to the right of the Reset button).

There's also a CHG LED next to the USB jack, which will light up while the battery is
charging. This LED might also flicker if the battery is not connected, it's normal.

The charge LED is automatically driven by the LiPoly charger circuit. It will try to

detect a battery and is expecting one to be attached. If there isn't one it may
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flicker once in a while when you use power because it's trying to charge a (non-

existent) battery. It's not harmful, and its totally normal!

Power Supplies

You have a lot of power supply options here! We bring out the BAT pin, which is tied
to the LiPoly JST connector, as well as USB which is the +5V from USB if connected.
We also have the 3V pin which has the output from the 3.3V regulator. We use a
500mA peak regulator. While you can get 500mA from it, you can't do it continuously
from 5V as it will overheat the regulator.

It's fine for, say, powering an ESP8266 WiFi chip or XBee radio though, since the
current draw is 'spikey' & sporadic.

Measuring Battery

If you're running off of a battery, chances are you wanna know what the voltage is at!
That way you can tell when the battery needs recharging. LiPoly batteries are 'maxed
out' at 4.2V and stick around 3.7V for much of the battery life, then slowly sink down
to 3.2V or so before the protection circuitry cuts it off. By measuring the voltage you
can quickly tell when you're heading below 3.7V.

To make this easy we stuck a double-100K resistor divider on the BAT pin, and
connected it to D9 (a.k.a analog #7 A7). You can read this pin's voltage, then double it,
to get the battery voltage.

#define VBATPIN A7
float measuredvbat = analogRead(VBATPIN);

measuredvbat *= 2; // we divided by 2, so multiply back
measuredvbat *= 3.3; // Multiply by 3.3V, our reference voltage
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measuredvbat /= 1024; // convert to voltage
Serial.print("VBat: " ); Serial.println(measuredvbat);

This voltage will 'float' at 4.2V when no battery is plugged in, due to the lipoly charger
output, so its not a good way to detect if a battery is plugged in or not (there is no
simple way to detect if a battery is plugged in)

ENable pin

If you'd like to turn off the 3.3V regulator, you can do that with the EN(able) pin. Simply
tie this pin to Ground and it will disable the 3V regulator. The BAT and USB pins will
still be powered.
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Alternative Power Options

The two primary ways for powering a feather are a 3.7/4.2V LiPo battery plugged into
the JST port or a USB power cable.
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If you need other ways to power the Feather, here's what we recommend:

« For permanent installations, a 5V 1A USB wall adapter () will let you plug in a

USB cable for reliable power
- For mobile use, where you don't want a LiPoly, use a USB battery pack! ()

« If you have a higher voltage power supply, use a 5V buck converter () and wire it
to a USB cable's 5V and GND input ()

Here's what you cannot do:

« Do not use alkaline or NiMH batteries and connect to the battery port - this will
destroy the LiPoly charger and there's no way to disable the charger
« Do not use 7.4V RC batteries on the battery port - this will destroy the board

The Feather is not designed for external power supplies - this is a design decision to
make the board compact and low cost. It is not recommended, but technically
possible:

« Connect an external 3.3V power supply to the 3V and GND pins. Not
recommended, this may cause unexpected behavior and the EN pin will no
longer work. Also this doesn't provide power on BAT or USB and some
Feathers/Wings use those pins for high current usages. You may end up
damaging your Feather.

« Connect an external 5V power supply to the USB and GND pins. Not
recommended, this may cause unexpected behavior when plugging in the USB
port because you will be back-powering the USB port, which could confuse or
damage your computer.

Arduino IDE Setup

The first thing you will need to do is to download the latest release of the Arduino
IDE. You will need to be using version 1.8 or higher for this guide

Arduino IDE Download

After you have downloaded and installed the latest version of Arduino IDE, you will
need to start the IDE and navigate to the Preferences menu. You can access it from
the File menu in Windows or Linux, or the Arduino menu on OS X.
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-
Blink | Arduino 1.8.2

New

Open...
Open Recent
Sketchbook
Examples
Close

| Save

Save As...

Page Setup
Print

Preferences

Quit

File| Edit Sketch Tools Help

Ctrl+N
Ctrl+O

Ctrl+W
Ctrl+S
Ctrl+Shift+S

Ctrl+Shift+P
Ctrl+P

Ctrl+ Comma

Ctrl+Q

A dialog will pop up just like the one shown below.

Preferences

Additional Boards Manager URLs: |

More preferences can be edited directly

C:\Users\halbe \OneDrive \Documents\ArduinoData \preferences. txt

(edit only when Arduino is not running

Settings Network
Sketchbook location:
C:\Users\halbe\OneDrive \Dx duino
Editor language: System Default v | (requires restart of Arduino)
Editor font size: 12
Interface scale: [M Automatic = 100 % (requires restart of Arduino)
Theme: Default theme « (requires restart of Arduino)
Show verbose output during: [] complation [] upload
Compiler warnings: Al v
[ Display line numbers [[] Enable Code Folding
Verify code after upload [ Use external editor
[¥] Check for updates on startup [] Save when verifying or uploading
[[] use accessibility features

We will be adding a URL to the new Additional Boards Manager URLs option. The list
of URLs is comma separated, and you will only have to add each URL once. New
Adafruit boards and updates to existing boards will automatically be picked up by the
Board Manager each time it is opened. The URLs point to index files that the Board

Manager uses to build the list of available & installed boards.

To find the most up to date list of URLs you can add, you can visit the list of third party
board URLs on the Arduino IDE wiki (). We will only need to add one URL to the IDE in

this example, but you can add multiple URLS by separating them with commas. Copy
and paste the link below into the Additional Boards Manager URLs option in the

Arduino IDE preferences.
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https://adafruit.github.io/arduino-board-index/
package adafruit index.json

Preferences
Settings Network
Sketchbook location:

C:\Users \halbe \OneDrive \Documents \Arduino Browse

Editor language: System Default v | (requires restart of Arduino)
Editor font size: 12
Interface scale: M Automatic = 100 % (requires restart of Arduino)
Theme: Default theme «  (requires restart of Arduino)
Show verbose output during: [_] compiation upload
Compiler warnings: None
[ Display line numbers [[] Enable Code Folding
Verify code after upload [[] use external editor
[~ Check for updates on startup [4] Save when verifying or uploading
[[] use accessibility features
Additional Boards Manager URLs:  https:, //adafrut,gthb.|o/ardumo~board-mdex/pad(age_adafrwt_ﬂdex;sod ﬁ

C:\Users\halbe \OneDrive \Documents\ArduinoData \preferences. txt
(edit only when Arduino is not running

OK Cancel

Here's a short description of each of the Adafruit supplied packages that will be
available in the Board Manager when you add the URL:

- Adafruit AVR Boards - Includes support for Flora, Gemma, Feather 32u4,
ltsyBitsy 32u4, Trinket, & Trinket Pro.

« Adafruit SAMD Boards - Includes support for Feather MO and M4, Metro MO and
M4, ItsyBitsy MO and M4, Circuit Playground Express, Gemma MO and Trinket
MO

« Arduino Leonardo & Micro MIDI-USB - This adds MIDI over USB support for the
Flora, Feather 32u4, Micro and Leonardo using the arcore project ().

If you have multiple boards you want to support, say ESP8266 and Adafruit, have
both URLs in the text box separated by a comma (,)

Once done click OK to save the new preference settings. Next we will look at
installing boards with the Board Manager.

Now continue to the next step to actually install the board support package!

Using with Arduino IDE

The Feather/Metro/Gemma/QTPy/Trinket MO and M4 use an ATSAMD21 or ATSAMD51
chip, and you can pretty easily get it working with the Arduino IDE. Most libraries

(including the popular ones like NeoPixels and display) will work with the MO and M4,
especially devices & sensors that use [12C or SPI.
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Now that you have added the appropriate URLs to the Arduino IDE preferences in the
previous page, you can open the Boards Manager by navigating to the Tools->Board

menu.

File Edit Sketch Help
Auto Format
Archive Sketch
Fix Encoding & Reload
Serial Monitor

Ctrl+T

sketch_nov27z

1 void setup Ctrl+Shift+M

Boards Manager...

2 // put y

3 Board: "Arduino/Genuino Uno"

: } Port

f void loop Programmer: "USBtinyISP"

é // puc y Burn Bootloader ¢

Arduino AVR Boards
Arduino Yin
Arduino/Genuino Uno

Arduino Duemilanove or Diecimila

Once the Board Manager opens, click on the category drop down menu on the top
left hand side of the window and select All. You will then be able to select and install

the boards supplied by the URLs added to the preferences.

Install SAMD Support

First up, install the latest Arduino SAMD Boards (version 1.6.11 or later)

You can type Arduino SAMD in the top search bar, then when you see the entry, click |

nstall

v] ‘F'/lef your search...

Arduino SAM Boards (32-bits ARM Cortex-M3) by Arduino version 1.6.6 INSTALLED
Boards included in this package:

Arduino Due.

Online help

More info

Arduino SAMD Boards (32-bits ARM Cortex-M0+) by Arduino
Boards included in this package:
Arduino/Genuino Zero.

©Adafruit Industries

Online help.

More info

Intel i586 Boards by Intel

Boards included in this package:

Galileo.

More info

pee I
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Install Adafruit SAMD

Next you can install the Adafruit SAMD package to add the board file definitions
Make sure you have Type All selected to the left of the Filter your search... box

You can type Adafruit SAMD in the top search bar, then when you see the entry, click |
nstall

€9 Boards Manager ) [E

|| Type :AII v: Filter your seardh...

Boards included in this package: R
l Adafruit Flora, Adafruit Gemma 8MHz, Adafruit Bluefruit Micro, Adafruit Feather 32u4, Adafruit Metro, Adafruit Pro Trinket
5V/16MHz (USB), Adafruit Pro Trinket 3V/12MHz (USB), Adafruit Pro Trinket 5V/16MHz (FTDI), Adafruit Pro Trinket 3V/12MHz
(FTDI), Adafruit Trinket 8MHz, Adafruit Trinket 16MHz.
Online help
More info

Adafruit SAMD Boards by Adafruit
Boards included in this package:
Adafruit Feather MO.

Online hel
More info

|
Leonardo & Micro MIDI-USB (arcore) by Ralf Kistner =
Boards included in this package:

Even though in theory you don't need to - | recommend rebooting the IDE

Quit and reopen the Arduino IDE to ensure that all of the boards are properly
installed. You should now be able to select and upload to the new boards listed in the
Tools->Board menu.

Select the matching board, the current options are:

« Feather MO (for use with any Feather MO other than the Express)

« Feather MO Express

« Metro MO Express

« Circuit Playground Express

« Gemma MO

« Trinket MO

+ QT Py MO

« ItsyBitsy MO

« Hallowing MO

« Crickit MO (this is for direct programming of the Crickit, which is probably not
what you want! For advanced hacking only)

« Metro M4 Express
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« Grand Central M4 Express

- ltsyBitsy M4 Express
- Feather M4 Express
- Trellis M4 Express

» PyPortal M4

« PyPortal M4 Titano

- PyBadge M4 Express
+ Metro M4 Airlift Lite

« PyGamer M4 Express

+ MONSTER M4SK

» Hallowing M4

« MatrixPortal M4

- BLM Badge

File Edit Sketch Help

doubleWide

// Example/di
// is a disti
// For more c

// included w

// Also requil
// Rhdafruit ¥

// May requir|
// or use Neo

#include <Ada|

Auto Format

Archive Sketch

Fix Encoding & Reload
Serial Monitor

Serial Plotter

WiFi101 Firmware Updater

Board: "Adafruit ItsyBitsy M4 (SAMD51)"

Port
Get Board Info

Programmer: "USBtinyISP"

Burn Bootloader

#define NUM_LED 64 // Per strand. Total number of pixels is

// Second argument to constructor is an optional &-byte pin )

N _

Ctrl+Shift+M |of 2 strands
Ctrl+Shift+L } strand.

A
Adafruit SAMD (32-bits ARM Cortex-M0+ and Cortex-Md) Boards
Adafruit Feather MO
Adafruit Feather MO Express
Adafruit Metro MO Express
Adafruit Circuit Playground Express
L Adafruit Gemma MO
Adafruit Trinket MO
Adafruit ItsyBitsy MO
Adafruit plRkey
Adafruit Metro M4 (SAMDS1)

Install Drivers (Windows 7 & 8 Only)

When you plug in the board, you'll need to possibly install a driver

Click below to download our Driver Installer

Download Latest Adafruit Drivers

Download and run the installer
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https://github.com/adafruit/Adafruit_Windows_Drivers/releases

fa N
Opening adafruit_drivers.exe ﬂ

You have chosen to open:

n] adafruit_drivers.exe

which is: Binary File (13.6 MB)
from: https://github-cloud.s3.amazonaws.com

Would you like to save this file?

[ Save File ] Cancel

-
3¢ Adafruit Board Drivers: .License Agreement ==

Please review the license agreement before installing Adafruit board
drivers. If you accept all terms of the agreement, dick I Agree.

h’his program will allow you to install Windows drivers for ~ +
hardware that Adafruit Industries produces. Please support L4
Adafruit by purchasing hardware from:
<http://www.adafruit.com/>

Note you can uninstall any of the installed drivers by using
the Add/Remove Programs option in Control Panel (look for
the "Windows Driver Package' entries from Adafruit).

Cancel I Mullsoft Install System v3.0b3 I Agree

Run the installer! Since we bundle the SiLabs and FTDI drivers as well, you'll need to
click through the license

Select which drivers you want to install, the defaults will set you up with just about

every Adafruit board!
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Check the board drivers below that you would like to install. Click install to
start the installation.

Select board drivers to install: Feather 32u4, Feather M0, Feather MO E
Feather WICED
Trinket / Pro Trinket / Gemma (USBtinyISP)
[ Arduino Gemma
[[] Feather HUZZAH ESP8266 (SiLabs CP210x)
[ Metro 328 / Metro Mini 328 (FTDI VCP and

>

Cancel I Nullsoft Install System v3.02,1 < Back “ Install I

Click Install to do the installin'

a4 = B
st Adafruit Board Drivers: Completed”[dﬂlg

Completed

Show details I

Cancel Mullsoft Install System v3.0b3 < Back

Blink

Now you can upload your first blink sketch!
Plug in the MO or M4 board, and wait for it to be recognized by the OS (just takes a

few seconds). It will create a serial/COM port, you can now select it from the drop-
down, it'll even be 'indicated' as Trinket/Gemma/Metro/Feather/ItsyBitsy/Trellis!
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Please note, the QT Py and Trellis M4 Express are two of our very few boards that
does not have an onboard pin 13 LED so you can follow this section to practice
uploading but you wont see an LED blink!

V A
sketch_nov23a | Arduino 164 - e~
File Edit Sketch Help

Auto Format Ctrl+T
Archive Sketch

sketch_novz3s Fix Encoding & Reload
void setup() Serial Monitor Ctrl+Shift+M i
// put your
Board: "Adafruit Feather..." 4
} Port: "COMS52 (Adafruit ..." Serial ports
void loop com1
vold loop() { Programmer: "AVRISP mkII"
Il // put your v COMS2 (Adafruit Feather MO (Native USB Port))
Burn Bootloader I =
4l Irr

Now load up the Blink example

// the setup function runs once when you press reset or power the board
void setup() {

// initialize digital pin 13 as an output.

pinMode (13, OUTPUT);

// the loop function runs over and over again forever
void loop() {
digitalWrite(13, HIGH); // turn the LED on (HIGH is the voltage level)

delay(1000); // wait for a second
digitalWrite(13, LOW); // turn the LED off by making the voltage LOW
delay(1000); // wait for a second

}

And click upload! That's it, you will be able to see the LED blink rate change as you
adapt the delay() calls.

If you are having issues, make sure you selected the matching Board in the menu

that matches the hardware you have in your hand.

Successful Upload

If you have a successful upload, you'll get a bunch of red text that tells you that the
device was found and it was programmed, verified & reset
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4 [m

»
Adafruit Feather MO (Native USB Port) on COMS4 I

After uploading, you may see a message saying "Disk Not Ejected Properly" about the
...BOOT drive. You can ignore that message: it's an artifact of how the bootloader and
uploading work.

Compilation Issues

If you get an alert that looks like
Cannot run program "{runtime.tools.arm-none-eabi-gcc.path}\bin\arm-non-eabi-g++"

Make sure you have installed the Arduino SAMD boards package, you need both Ard
uino & Adafruit SAMD board packages

, MANUFACTURE
Users\la
Users\la
Users\lady
:\Users\ladyad

Adafruit Feather MO (Native USB Port) on COM11
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Manually bootloading

If you ever get in a 'weird' spot with the bootloader, or you have uploaded code that
crashes and doesn't auto-reboot into the bootloader, click the RST button twice (like a
double-click)to get back into the bootloader.

The red LED will pulse and/or RGB LED will be green, so you know that its in
bootloader mode.

Once it is in bootloader mode, you can select the newly created COM/Serial port and
re-try uploading.

File Edit Sketch Help

Auto Format Ctrl+T
Archive Sketch
Fix Encoding & Reload

sketch_nov27g

Serial Monitor Ctrl+ShiftsM & board
Board: "Adafruit Feather MO (Native USB Port)" |
Port Serial ports

comi
Ccom12
COM129 (Adafruit Feather MO (Native USB Port))

Programmer: "USBtinyISP"

Burn Bootloader

digitalWrite (13, HIGH): // turn the LED on (HIGH is the vo =
delay(1000); // wait for a second
digitalWrite (13, LOW); // turn the LED off by making the voltage LOW

You may need to go back and reselect the 'normal' USB serial port next time you want
to use the normal upload.

Ubuntu & Linux Issue Fix

Follow the steps for installing Adafruit's udev rules on this page. ()

Adapting Sketches to MO & M4

The ATSAMD21 and 51 are very nice little chips, but fairly new as Arduino-compatible
cores go. Most sketches & libraries will work but here’s a collection of things we
noticed.

The notes below cover a range of Adafruit MO and M4 boards, but not every rule will

apply to every board (e.g. Trinket and Gemma MO do not have ARef, so you can skip
the Analog References note!).
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Analog References

If you'd like to use the ARef pin for a non-3.3V analog reference, the code to use is
analogReference (AR _EXTERNAL) (it's AR_EXTERNAL not EXTERNAL)

Pin Outputs & Pullups

The old-style way of turning on a pin as an input with a pullup is to use

pinMode(pin, INPUT)
digitalWrite(pin, HIGH)

This is because the pullup-selection register on 8-bit AVR chips is the same as the
output-selection register.

For MO & M4 boards, you can't do this anymore! Instead, use:
pinMode(pin, INPUT PULLUP)

Code written this way still has the benefit of being backwards compatible with AVR.
You don’t need separate versions for the different board types.

Serial vs SerialUSB

99.9% of your existing Arduino sketches use Serial.print to debug and give output. For
the Official Arduino SAMD/MO core, this goes to the Serial5 port, which isn't exposed
on the Feather. The USB port for the Official Arduino MO core is called SerialUSB
instead.

In the Adafruit MO/M4 Core, we fixed it so that Serial goes to USB so it will
automatically work just fine.

However, on the off chance you are using the official Arduino SAMD core and not the
Adafruit version (which really, we recommend you use our version because it’s been
tuned to our boards), and you want your Serial prints and reads to use the USB port,
use SerialUSB instead of Serial in your sketch.
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If you have existing sketches and code and you want them to work with the MO
without a huge find-replace, put

#if defined (ARDUINO SAMD ZERO) && defined(SERIAL PORT USBVIRTUAL)
// Required for Serial on Zero based boards
#define Serial SERIAL_PORT_USBVIRTUAL

#endif

right above the first function definition in your code. For example:

File Edit Sketch Tools Help

datecalc §

// Simple date conversions and calculations

[wm

3 #include <Wire.h>
' 4 #include "RTClib.h" '

€ #if defined (ARDUINO_ARCH_SAMD)

7 // for Zero, output on USB Serial console, remove line below if using programming port to program the Zero!
& #define Serial SerialUSB

9 #endif

11 void showDate (const char* txt, const DateTime: dt) {
Serial.print(txt):
Serial.print(' ');

AnalogWrite / PWM on Feather/Metro MO

After looking through the SAMD21 datasheet, we've found that some of the options
listed in the multiplexer table don't exist on the specific chip used in the Feather MO.

For all SAMD21 chips, there are two peripherals that can generate PWM signals: The
Timer/Counter (TC) and Timer/Counter for Control Applications (TCC). Each SAMD21
has multiple copies of each, called 'instances'.

Each TC instance has one count register, one control register, and two output
channels. Either channel can be enabled and disabled, and either channel can be
inverted. The pins connected to a TC instance can output identical versions of the
same PWM waveform, or complementary waveforms.

Each TCC instance has a single count register, but multiple compare registers and
output channels. There are options for different kinds of waveform, interleaved

switching, programmable dead time, and so on.

The biggest members of the SAMD21 family have five TC instances with two
'‘waveform output' (WO) channels, and three TCC instances with eight WO channels:

. TC[0-4],WO[0-1]
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. TCC[0-2],WO[0-7]

And those are the ones shown in the datasheet's multiplexer tables.

The SAMD21G used in the Feather MO only has three TC instances with two output
channels, and three TCC instances with eight output channels:

. TC[3-5],WO[0-1]
. TCC[0-2],WO[0-7]

Tracing the signals to the pins broken out on the Feather MO, the following pins can't
do PWM at all:

» Analog pin A5

The following pins can be configured for PWM without any signal conflicts as long as
the SPI, I12C, and UART pins keep their protocol functions:

- Digital pins 5, 6, 9,10, 11, 12, and 13
« Analog pins A3 and A4

If only the SPI pins keep their protocol functions, you can also do PWM on the
following pins:

« TX and SDA (Digital pins 1 and 20)

analogWrite() PWM range

On AVR, if you set a pin's PWM with analogWrite(pin, 255) it will turn the pin fully
HIGH. On the ARM cortex, it will set it to be 255/256 so there will be very slim but
still-existing pulses-to-0V. If you need the pin to be fully on, add test code that checks
if you are trying to analogWrite(pin, 255) and, instead, does a
digitalWrite(pin, HIGH)
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analogWrite() DAC on AO

If you are trying to use analogWrite() to control the DAC output on AO, make sure
you do not have a line that sets the pin to output. Remove: pinMode (A0, OUTPUT) .

Missing header files

There might be code that uses libraries that are not supported by the MO core. For
example if you have a line with

#include <util/delay.h>
you'll get an error that says

fatal error: util/delay.h: No such file or directory
#include <util/delay.h>

compilation terminated.

Error compiling.

In which case you can simply locate where the line is (the error will give you the file
name and line number) and 'wrap it' with #ifdef's so it looks like:

#if !defined (ARDUINO ARCH SAM) &amp;&amp; !defined(ARDUINO ARCH _SAMD) &amp;&amp; !
defined (ESP8266) &amp;&amp; !'defined(ARDUINO ARCH STM32F2)

#include &lt;util/delay.h&gt;

#endif

The above will also make sure that header file isn't included for other architectures

If the #include is in the arduino sketch itself, you can try just removing the line.

Bootloader Launching

For most other AVRs, clicking reset while plugged into USB will launch the bootloader
manually, the bootloader will time out after a few seconds. For the MO/M4, you'll need
to double click the button. You will see a pulsing red LED to let you know you're in
bootloader mode. Once in that mode, it wont time out! Click reset again if you want to
go back to launching code.
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Aligned Memory Access

This is a little less likely to happen to you but it happened to me! If you're used to 8-
bit platforms, you can do this nice thing where you can typecast variables around. e.g.

uint8 t mybuffer([4];
float f = (float)mybuffer;

You can't be guaranteed that this will work on a 32-bit platform because mybuffer
might not be aligned to a 2 or 4-byte boundary. The ARM Cortex-MO can only directly
access data on 16-bit boundaries (every 2 or 4 bytes). Trying to access an odd-
boundary byte (on a 1 or 3 byte location) will cause a Hard Fault and stop the MCU.
Thankfully, there's an easy work around ... just use memcpy!

uint8 t mybuffer([4];
float f;
memcpy (&f, mybuffer, 4)

Floating Point Conversion

Like the AVR Arduinos, the MO library does not have full support for converting
floating point numbers to ASCII strings. Functions like sprintf will not convert floating
point. Fortunately, the standard AVR-LIBC library includes the dtostrf function which
can handle the conversion for you.

Unfortunately, the MO run-time library does not have dtostrf. You may see some
references to using #include <avr/dtostrf.h> to get dtostrf in your code. And while it

will compile, it does not work.

Instead, check out this thread to find a working dtostrf function you can include in
your code:

http://forum.arduino.cc/index.php?topic=368720.0 ()

How Much RAM Available?

The ATSAMD21G18 has 32K of RAM, but you still might need to track it for some
reason. You can do so with this handy function:
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extern "C" char *sbrk(int 1i);

int FreeRam () {

char stack dummy = 0;

return &amp;stack _dummy - sbrk(0);
}

Thx to http://forum.arduino.cc/index.php?topic=365830.msg2542879#msg2542879 ()
for the tip!

Storing data in FLASH

If you're used to AVR, you've probably used PROGMEM to let the compiler know
you'd like to put a variable or string in flash memory to save on RAM. On the ARM, its
a little easier, simply add const before the variable name:

const char str[] = "My very long string";
That string is now in FLASH. You can manipulate the string just like RAM data, the
compiler will automatically read from FLASH so you dont need special progmem-

knowledgeable functions.

You can verify where data is stored by printing out the address:
Serial.print("Address of str $"); Serial.printin((int)&str, HEX);

If the address is $2000000 or larger, its in SRAM. If the address is between $0000
and $3FFFF Then it is in FLASH

Pretty-Printing out registers

There's a lot of registers on the SAMD21, and you often are going through ASF or
another framework to get to them. So having a way to see exactly what's going on is
handy. This library from drewfish will help a ton!

https://github.com/drewfish/arduino-ZeroRegs ()
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M4 Performance Options

As of version 1.4.0 of the Adafruit SAMD Boards package in the Arduino Boards
Manager, some options are available to wring extra performance out of M4-based
devices. These are in the Tools menu.

Sketch MLIEN Help

CPU Speed: "200 MHz (overclock)"

v 200 MHz (overclock)

All of these performance tweaks involve a degree of uncertainty. There’s no
guarantee of improved performance in any given project, and some may even be
detrimental, failing to work in part or in whole. If you encounter trouble, select the
default performance settings and re-upload.

Here’s what you get and some issues you might encounter...

CPU Speed (overclocking)

This option lets you adjust the microcontroller core clock...the speed at which it
processes instructions...beyond the official datasheet specifications.

Manufacturers often rate speeds conservatively because such devices are marketed
for harsh industrial environments...if a system crashes, someone could lose a limb or
worse. But most creative tasks are less critical and operate in more comfortable
settings, and we can push things a bit if we want more speed.

There is a small but nonzero chance of code locking up or failing to run entirely. If this
happens, try dialing back the speed by one notch and re-upload, see if it's more
stable.

Much more likely, some code or libraries may not play well with the nonstandard CPU

speed. For example, currently the NeoPixel library assumes a 120 MHz CPU speed
and won’t issue the correct data at other settings (this will be worked on). Other
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libraries may exhibit similar problems, usually anything that strictly depends on CPU
timing...you might encounter problems with audio- or servo-related code depending
how it’s written. If you encounter such code or libraries, set the CPU speed to the
default 120 MHz and re-upload.

Optimize

There’s usually more than one way to solve a problem, some more resource-intensive
than others. Since Arduino got its start on resource-limited AVR microcontrollers, the
C++ compiler has always aimed for the smallest compiled program size. The
“Optimize” menu gives some choices for the compiler to take different and often
faster approaches, at the expense of slightly larger program size...with the huge flash
memory capacity of M4 devices, that’s rarely a problem now.

The “Small” setting will compile your code like it always has in the past, aiming for the
smallest compiled program size.

The “Fast” setting invokes various speed optimizations. The resulting program should
produce the same results, is slightly larger, and usually (but not always) noticably
faster. It’'s worth a shot!

“Here be dragons” invokes some more intensive optimizations...code will be larger
still, faster still, but there’s a possibility these optimizations could cause unexpected
behaviors. Some code may not work the same as before. Hence the name. Maybe
you’ll discover treasure here, or maybe you’ll sail right off the edge of the world.

Most code and libraries will continue to function regardless of the optimizer settings.
If you do encounter problems, dial it back one notch and re-upload.

Cache

This option allows a small collection of instructions and data to be accessed more
quickly than from flash memory, boosting performance. It’s enabled by default and
should work fine with all code and libraries. But if you encounter some esoteric
situation, the cache can be disabled, then recompile and upload.

Max SPI and Max QSPI

These should probably be left at their defaults. They’re present mostly for our own
experiments and can cause serious headaches.
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Max SPI determines the clock source for the M4’s SPI peripherals. Under normal
circumstances this allows transfers up to 24 MHz, and should usually be left at that
setting. But...if you’re using write-only SPI devices (such as TFT or OLED displays), this
option lets you drive them faster (we’ve successfully used 60 MHz with some TFT
screens). The caveat is, if using any read/write devices (such as an SD card), this will
not work at all...SPI reads absolutely max out at the default 24 MHz setting, and
anything else will fail. Write = OK. Read = FAIL. This is true even if your code is using a
lower bitrate setting...just having the different clock source prevents SPI reads.

Max QSPI does similarly for the extra flash storage on M4 “Express” boards. Very few
Arduino sketches access this storage at all, let alone in a bandwidth-constrained
context, so this will benefit next to nobody. Additionally, due to the way clock dividers
are selected, this will only provide some benefit when certain “CPU Speed” settings
are active. Our PyPortal Animated GIF Display () runs marginally better with it, if using
the QSPI flash.

Enabling the Buck Converter on some M4
Boards

If you want to reduce power draw, some of our boards have an inductor so you can
use the 1.8V buck converter instead of the built in linear regulator. If the board does
have an inductor (see the schematic) you can add the line SUPC->VREG.bit.SEL =
1; to your code to switch to it. Note it will make ADC/DAC reads a bit noisier so we
don't use it by default. You'll save “4mA ().

Installing BLE Library
Install the Adafruit nRF51 BLE Library

In order to try out our demos, you'll need to download the Adafruit BLE library for the
nRF51 based modules such as this one (a.k.a. Adafruit_BluefruitLE_nRF51)

You can check out the code here at github, () but its likely easier to just download by
clicking:

Download the Adafruit nRF51

BluefruitLE library
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Rename the uncompressed folder Adafruit_BluefruitLE_nRF51 and check that the Ada
fruit_BluefruitLE_nRF51 folder contains Adafruit_BLE.cpp and Adafruit_BLE.h (as well
as a bunch of other files)

Place the Adafruit_BluefruitLE_nRF51 library folder your arduinosketchfolder/libraries/

folder.

You may need to create the libraries subfolder if its your first library. Restart the IDE.

We also have a great tutorial on Arduino library installation at:

http://learn.adafruit.com/adafruit-all-about-arduino-libraries-install-use ()

After restarting, check that you see the library folder with examples:

29 sketch_may0la | Arduino 16.

Edit Sketch Tools Help

Adafruit_ 9DOF
Adafruit_ADS1015
Adafruit_ADXL345_U
Adafruit_AHRS
Adafruit_AM2315
Adafruit_AS3935
Adafruit_BLEFirmata

Adafruit_BLEModule_SPISlave
Adafruit_BluefruitLE_nRF51
Adafruit_BMP085
Adafruit_BMP085_Unified
Adafruit_BMP183
Adafruit_BMP183_Unified

atcommand

beacon
bleuart
factoryreset

heartratemonitor

New Ctrl+N
Open... Ctrl+O
Sketchbook
Examples
Close Ctrl+W
Save Ctrl+S
Save As... Ctrl+Shift+S
Upload Ctrl+U
Upload Using Programmer Ctrl+Shift+U
Page Setup Ctrl+Shift+P
Print Ctrl+P
Preferences Ctrl+Comma
.
Run first example

Adafruit_BNO055
Adafruit_CAP1188

hidkeyboard

uribeacon

Lets begin with the beginner project, which we can use to do basic tests. To open the
ATCommand sketch, click on the File > Examples > Adafruit_BluefruitLE_nRF51 folder

in the Arduino IDE and select atcommand:

Adafruit_AHRS

Adafruit_BluefruitLE_nRF51
Adafruit_BMP085_Unified
Adafruit_BMP183_Unified_Library

Adafruit_BNO055
Adafruit_CC3100
Adafruit_DHT_Unified
Adafruit_DotStar
Adafruit_FONA_Library

VVYVVVVVAAY

atcommand
beacon

bleuart
factoryreset
heartratemonitor
hidkeyboard
uribeacon

This will open up a new instance of the example in the IDE, as shown below:
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( - = N
atcommand | Arduino 1.6.4 L — —— EIM
File Edit Sketch Tools Help

atcommand

Bfile atcommand. ino
fauthor  hathach

This example shows how to connect to your Adafruit Bluefruit LE (nrf£51822) and do
some basic AT commands to check connectivity, print out the version strings and let
|| You send your own AT commands!

#include <string.h>

#include <Arduino.h>

#include <SPI.h>

#if not defined (_VARIANT ARDUINO_DUE_X_)
#include <SoftwareSerial.h>

#endif

#include "Adafruit BLE.h"
#include "Adafruit BLE_HWSPI.h"
#include "Adafruit_BluefruitLE_UART.h"

// If you are using Software Serial....

// The following macros declare the pins used for S5W serial, you should

// use these pins if you are connecting the UART Friend to an UNO

#define BLUEFRUIT SWUART RXD_PIN 9 // Required for software serial!

HAnEivm~ DITMENITTT CITTATT TVH N in 11 Darmiivad €nv nnfesvavn anwiall

< | [ »

Arduino Uno on CO

Go to the second tab labeled BluefruitConfig.h and find these lines

// SHARED SPI SETTINGS

// The following macros declare the pins to use for HW and SW SPI communication.
// SCK, MISO and MOSI should be connected to the HW SPI pins on the Uno when

// using HW SPI. This should be used with nRF51822 based Bluefruit LE modules
// that use SPI (Bluefruit LE SPI Friend).

//

#define BLUEFRUIT SPI CS 8

#define BLUEFRUIT SPI IRQ 7

#define BLUEFRUIT SPI RST 6 // Optional but recommended, set to -1
if unused

And change (if it isnt already) the last line to:

#define BLUEFRUIT SPI RST 4 // Optional but recommended, set to -1
if unused

(The Bluefruit Feather has the reset on digital #4 not #6)
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Now go back to the main tab atcommand and look for this line of code

/* ...hardware SPI, using SCK/MOSI/MISO hardware SPI pins and then user
selected CS/IRQ/RST */

Adafruit BluefruitLE SPI ble(BLUEFRUIT SPI CS, BLUEFRUIT SPI IRQ,
BLUEFRUIT SPI RST);

Make sure that the second line is uncommented (it should be)

OK now you can upload to the Bluefruit Feather!

If you're using Ubuntu 15.04 or other Linux distributions and run into errors
attempting to upload a program to the board, scroll up to the Ubuntu and Linux
issue fix in the previous section

Uploading to the Feather Bluefruit LE

It's pretty easy to upload, first up make sure you have Adafruit Feather MO selected
on the boards dropdown

> - Arduino Kobot Motor
sketch_nov23a | Arduino 1.6.4 Pt
rduino Gemma
Glentxbtmtietct [TOOIS] Kici Adafruit Feather boards
Auto Format Crl+T Adafruit Feather
I e Adafruit SAMD Boards
sketch_nov233 Fix Encoding & Reload
void ue ©  Adafruit Feather MO (Native USB Port)
vold setup() Serial Monitor Ctrl+Shift+M
// put your ESP8266 Modules
Board: "Adafruit Feather..." ) Generic ESP8266 Module
| } Port: "COM52 (Adafruit ..." ) Adafruit HUZZAH ESP8266
voi oop NodeM P-12 Modul
void loop() { Programmer: "AVRISP mill \ odeMCU 0.9 (ESP-12 Module)
\| 7/ put your NodeMCU 1.0 (ESP-12E Module)
Burn Bootloader
W . Olimex MOD-WIFI-ESP8266(-DEV)

Also, in the Ports menu, look for the port labeled as such:

-
sketch_nov23a | Arduino 1.6.4 . = | &
File Edit Sketch Help
Auto Format Ctrl+T
Archive Sketch
sketch_nov233 Fix Encoding & Reload
void setup() Serial Monitor Ctrl+Shift+M 0
// put your
Board: "Adafruit Feather..." 4
I|? Port: "COMS52 (Adafruit ..." Serial ports
vo com1i
void loop() ( Programmer: "AVRISP mkII"
| // put your v COMS2 (Adafruit Feather MO (Native USB Port))
Burn Bootloader

U ‘ 1]

Now click the upload button on the Arduino IDE (or File Menu -> Upload)
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If all is good you will see Done Uploading in the status bar

s —— B - <
@ atcommand | Arduino 1.6.4 =NAEN X

File Edit Sketch Tools Help

m| »

10
11
12
13
14

15 #includa Zivduina by

< n »

Build options changed, rebuilding all

) ch uses 10,684 bytes (37%) of program storage space. Maximum is 28,672 bytes.

Global variables use 5 bytes of dynamic memory.

Adafruit Bluefruit Micro on COMES

4 [m

»
Adafruit Feather MO (Native USB Port) on COMS4 I

Compilation Issues

If you get an alert that looks like

Cannot run program "{runtime.tools.arm-none-eabi-gcc.path}]\bin\arm-non-eabi-g++"
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Make sure you have installed the Arduino SAMD boards package, you need both Ard
uino & Adafruit SAMD board packages

Manually bootloading

If you ever get in a 'weird' spot with the bootloader, or you have uploaded code that
crashes and doesn't auto-reboot into the bootloader, click the RST button twice (like a
double-click)to get back into the bootloader.

The red LED will pulse, so you know that its in bootloader mode.

Once itis in bootloader mode, you can select the newly created COM/Serial port and
re-try uploading.

Auto Format
Archive Sketch

Fix Encoding & Reload

Serial Monitor Ctrl+Shift+M

e board

Board: "Adafruit Feather MO (Native USB Port)" >
Port Serial ports
5 comiL
Programmer: "USBtinyISP"
CoMm12

Burn Bootloader

COM129 (Adafruit Feather MO (Native USB Port))
digitalWrite (13, HIGH): // turn the LED on (HIGH is the volcugc— x

10 delay(1000); // wait for a second
11 digitalWrite (13, LOW); // turn the LED off by making the voltage LOW

You may need to go back and reselect the 'normal' USB serial port next time you want
to use the normal upload.

Run the sketch

OK check again that the correct port is selected

-
sketch_nov23a | Arduino 1.6.4 - = | &
File Edit Sketch Help
Auto Format Ctrl+T
Archive Sketch
Sketch_nov233 b Encoding & Reload
vold setup() Serial Monitor Ctrl+ Shift+M i
// put your
Board: "Adafruit Feather..." 4
I|? Port: "COMS52 (Adafruit ..." Serial ports
void loop com1
vold loop() { Programmer: "AVRISP mkII"
\| // put your v COMS2 (Adafruit Feather MO (Native USB Port))
Burn Bootloader

U J T

Then open up the Serial console. You will see the following:
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r N
COM68 (Adafruit Bluefruit Micro) el B

Adafruit Bluefruit AT Command Example
Initialising the Bluefruit LE module: OK!

f|Performing a factory reset:
AT+FACTORYRESET

<- OK
ATE=0

<- OK
Requesting Bluefruit info:
BLESPIFRIEND
nRF51822 QFACAlO
6992A797D32E2839
M0.6.5
0.6.5
Jul 1 2015
5110 &.0.0, 0.2

faT > l

[¥7] Autoscroll BothNL&CR v | | 115200 baud 1

This sketch starts by doing a factory reset, then querying the BLE radio for details.
These details will be useful if you are debugging the radio. If you see the information
as above, you're working! (Note that the dates and version numbers may vary)

AT command testing

Now you can try out some AT commands - check the rest of the learn guide for a full
list. We'll just start with AT+HWGETDIETEMP which will return the approximate
ambient temperature of the BLE chipset
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COM®68 (Adafruit Bluefruit Micro)

(AT-+HWGETDIETEMP h [ send |

Adafruit Bluefruit AT Command Example

Initialising the Bluefruit LE module: OK!
Performing a factory reset:
AT+FACTORYRESET

<- OK
ATE=0

<- OK
Requesting Bluefruit info:

BLESPIFRIEND
nRF51822 QFACALO
6992A797D32E2839
0.6.5

0.6.5

Jul 1 2015
/|S11l0 &.0.0, 0.2

AT >

[¥] Autoscrol BothNL&CR v | 115200 baud

" = — —
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@ COMBS (Adafruit Bluefruit Micro) S
e ———

|

Performing a factory reset: -
AT+FACTORYRESET

<- OK s
ATE=0

<- OK

Requesting Bluefruit info:
BLESPIFRIEND

||nRF51822 QFACAIL0
6992A797D32E2839

0.6.5

0.6.5

Jul 1 2015

5110 &8.0.0, 0.2

m

Autoscroll BothNL&CR v | | 115200 baud

OK now you know how to upload/test/communicate with your Feather MO Bluefruit. Next
up we have a bunch of tutorials who can follow for checking out the bluetooth le radio

and apps.

For all the following examples, we share the same code between various modules so do
n't forget to make sure you have the RESET pin set to 4 in BluefruitConfig.h for
each sketch before uploading, and that Hardware SPI mode is selected by
checking for

/* ...hardware SPI, using SCK/MOSI/MISO hardware SPI pins and then user selected CS/
IRQ/RST */

Adafruit BluefruitLE SPI ble(BLUEFRUIT SPI CS, BLUEFRUIT SPI IRQ,

BLUEFRUIT SPI RST);

Configuration!

Before you start uploading any of the example sketches, you'll need to

CONFIGURE the Bluefruit interface - there's a lot of options so pay close
attention!
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Which board do you have?

There's a few products under the Bluefruit name:

O,

)%

0.0.0.0.0
o o°o°o°o:3b

OOO

N~ ] (=)

eathér %

Blt.m‘rui!:".zw-1 "!mu?
- ey o

M=
| Feather He
Blueiruit

©Adafruit Industries

If you are using the Bluefruit LE Shield
then you have an SPI-connected
NRF51822 module. You can use this with
Atmega328 (Arduino UNO or compatible),
ATmega32u4 (Arduino Leonardo,
compatible) or ATSAMD21 (Arduino Zero,
compatible) and possibly others.

Your pinouts are Hardware SPI, CS = 8,
IRQ=7,RST=4

Bluefruit Micro or Feather
32u4 Bluefruit

If you have a Bluefruit Micro or Feather
32u4 Bluefruit LE then you have an
ATmega32u4 chip with Hardware SPI, CS =
8,IRQ=7,RST =4

Feather MO Bluefruit LE

If you have a Feather MO Bluefruit LE then
you have an ATSAMD21 chip with
Hardware SPI,CS=8,IRQ=7,RST =4
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Bluefruit LE SPI Friend

If you have a stand-alone module, you
have a bit of flexibility with wiring however
we strongly recommend Hardware SPI, CS
=8,IRQ=7,RST=4

You can use this with just about any
microcontroller with 5 or 6 pins

Bluefruit LE UART Friend or
Flora BLE

If you have a stand-alone UART module
you have some flexibility with wiring.
However we suggest hardware UART if
possible. You will likely need to use the
flow control CTS pin if you are not using
hardware UART. There's also a MODE pin

You can use this with just about any
microcontroller with at least 3 pins, but
best used with a Hardware Serial/UART
capable chip!

Configure the Pins Used

You'll want to check the Bluefruit Config to set up the pins you'll be using for UART or
SPI

Each example sketch has a secondary tab with configuration details. You'll want to
edit and save the sketch to your own documents folder once set up.
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(5 o TS

File Edit Sketch Tools Help

BluefruitConfig.h

/ COMMON SETTINGS -
/7
// These settings are used in both 5W UART, HW UART and SPI mode

\ // -
#define BUFSIZE 128 // Size of the read buffer for incoming data B
#define VERBOSE_MODE true // If set to 'true' enables debug output

// SOFTWARE UART SETTINGS
/7
// The following macros declare the pins that will be used for 'SW' serial.

// You should use this option if you are connecting the UART Friend to an UNO
/7
#define BLUEFRUIT_SWUART_RXD_PIN S // Recuired for software serial!

HAAEiw~ DITIOTNIITT CINIADT TUD DT 1n D T

Common settings:

You can set up how much RAM to set aside for a communication buffer and whether
you want to have full debug output. Debug output is 'noisy' on the serial console but
is handy since you can see all communication between the micro and the BLE

//

// These settings are used in both SW UART, HW UART and SPI mode

//

#define BUFSIZE 128 // Size of the read buffer for
incoming data

#define VERBOSE_ MODE true // If set to 'true' enables debug
output

Software UART

If you are using Software UART, you can set up which pins are going to be used for
RX, TX, and CTS flow control. Some microcontrollers are limited on which pins can be
used! Check the SoftwareSerial library documentation for more details

// SOFTWARE UART SETTINGS

#define BLUEFRUIT SWUART RXD PIN 9 // Required for software serial!
#define BLUEFRUIT SWUART TXD PIN 10 // Required for software serial!
#define BLUEFRUIT UART CTS PIN 11 // Required for software serial!
#define BLUEFRUIT UART RTS PIN -1 // Optional, set to -1 if unused

Hardware UART

If you have Hardware Serial, there's a 'name' for it, usually Seriall - you can set that up
here:
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// HARDWARE UART SETTINGS

#ifdef Seriall // this makes it not complain on compilation if there's no Seriall
#define BLUEFRUIT HWSERIAL NAME Seriall
#endif
Mode Pin

For both hardware and software serial, you will likely want to define the MODE pin.
There's a few sketches that dont use it, instead depending on commands to set/unset
the mode. Its best to use the MODE pin if you have a GPIO to spare!

#define BLUEFRUIT UART MODE PIN 12 // Set to -1 if unused

SPI Pins

For both Hardware and Software SPI, you'll want to set the CS (chip select) line, IRQ
(interrupt request) line and if you have a pin to spare, RST (Reset)

// SHARED SPI SETTINGS

#define BLUEFRUIT SPI CS 8
#define BLUEFRUIT SPI IRQ 7
#define BLUEFRUIT SPI RST 4 // Optional but recommended, set to -1

if unused

Software SPI Pins

If you don't have a hardware SPI port available, you can use any three pins...its a tad
slower but very flexible

// SOFTWARE SPI SETTINGS

#define BLUEFRUIT SPI SCK 13
#define BLUEFRUIT SPI MISO 12
#define BLUEFRUIT SPI MOSI 11

Refer to the table above to determine whether you have SPI or UART controlled

Bluefruits!

Select the Serial Bus

Once you've configured your pin setup in the BluefruitConfig.h file, you can now
check and adapt the example sketch.
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The Adafruit_BluefruitLE_nRF51 library supports four different serial bus options,
depending on the HW you are using: SPI both hardware and software type, and UART
both hardware and software type.

UART Based Boards (Bluefruit LE UART Friend & Flora
BLE)

This is for Bluefruit LE UART Friend & Flora BLE boards. You can use either software
serial or hardware serial. Hardware serial is higher quality, and less risky with respect
to losing data. However, you may not have hardware serial available! Software serial
does work just fine with flow-control and we do have that available at the cost of a
single GPIO pin.

For software serial (Arduino Uno, Adafruit Metro) you should uncomment the software
serial contructor below, and make sure the other three options (hardware serial & SPI)
are commented out.

// Create the bluefruit object, either software serial...uncomment these lines
SoftwareSerial bluefruitSS = SoftwareSerial (BLUEFRUIT SWUART TXD PIN,
BLUEFRUIT SWUART RXD PIN);

Adafruit BluefruitLE UART ble(bluefruitSS, BLUEFRUIT UART MODE PIN,
BLUEFRUIT UART CTS PIN, BLUEFRUIT UART RTS PIN);

For boards that require hardware serial (Adafruit Flora, etc.), uncomment the
hardware serial constructor, and make sure the other three options are commented
out

/* ...or hardware serial, which does not need the RTS/CTS pins. Uncomment this line
*/
Adafruit BluefruitLE UART ble(BLUEFRUIT HWSERIAL NAME, BLUEFRUIT UART MODE PIN);

SPI Based Boards (Bluefruit LE SPI Friend)

For SPI based boards, you should uncomment the hardware SPI constructor below,
making sure the other constructors are commented out:

/* ...hardware SPI, using SCK/MOSI/MISO hardware SPI pins and then user selected CS/
IRQ/RST */

Adafruit BluefruitLE SPI ble(BLUEFRUIT SPI CS, BLUEFRUIT SPI IRQ,
BLUEFRUIT _SPI RST);
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If for some reason you can't use HW SPI, you can switch to software mode to bit-bang

the SPI transfers via the following constructor:

/* ...software SPI, using SCK/MOSI/MISO user-defined SPI pins and then user

selected CS/IRQ/RST */

Adafruit BluefruitLE SPI ble(BLUEFRUIT SPI SCK, BLUEFRUIT SPI MISO,
BLUEFRUIT SPI_M0SI, BLUEFRUIT SPI CS,
BLUEFRUIT SPI_IRQ, BLUEFRUIT SPI RST);

ATCommand

The ATCommand example allows you to execute AT commands from your sketch, and

see the results in the Serial Monitor. This can be useful for debugging, or just testing
different commands out to see how they work in the real world. It's a good one to

start with!

Opening the Sketch

To open the ATCommand sketch, click on the File > Examples >
Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and select atcommand:

Adafruit_AHRS
Adafruit_BluefruitLE_nRF51
Adafruit_BMP085_Unified
Adafruit_BMP183_Unified_Library
Adafruit_BNO055
Adafruit_CC3100
Adafruit_DHT_Unified
Adafruit_DotStar
Adafruit_FONA_Library

VVVVVVYVYALAY

atcommand
beacon

bleuart
factoryreset
heartratemonitor
hidkeyboard
uribeacon

This will open up a new instance of the example in the IDE, as shown below:
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P N
atcommand | Arduino 1.6.4 R —— EJM

File Edit Sketch Tools Help

atcommand

>

/i 1
Bfile atcommand. ino

m

@fauthor  hathach

This example shows how to connect to your Adafruit Bluefruit LE (nrf51822) and do
some basic AT commands to check connectivity, print out the version strings and let
you send your own AT commands'

*/

#include <string.h>

#include <Arduino.h>

#include <SPI.h>

#if not defined (_VARIANT ARDUINO DUE_X_)
#include <SoftwareSerial.h>

#endif

#include "Adafruit BLE.h"
#include "Adafruit_BLE_HWSPI.h"
#include "Adafruit_BluefruitLE_UART.h"

// 1f you are using Software Serial....
// The following macros declare the pins used for 5W serial, you should
// use these pins if you are connecting the UART Friend to an UNO

#define BLUEFRUIT SWUART RXD_PIN 9 // Required for software serial!
I| 2amesmn ormEnITT ctmranm Tun nTe 1A 4 Pecmiiend ov cmeeeavn nmesadd M|
< | mn »

Arduino Uno on COM254

Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware
UART or Software/Hardware SPI. The default is hardware SPI

If using software or hardware Serial UART:
« This tutorial does not need to use the MODE pin, make sure you have the mode
switch in CMD mode if you do not configure & connect a MODE pin

« Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not
using it! (The Flora has this already done)

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and
the upload process has finished, open up the Serial Monitor via Tools > Serial Monitor,
and make sure that the baud rate in the lower right-hand corner is set to 115200:
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Initialising the Bluefruit LE module:
ATZ

<- OK

OK!

Performing a factory reset:
AT+FACTORYRESET

<- OK
ATE=0

<- ATE=0

OK

Requesting Bluefruit info:
BLEFRIEND32

nRF51822 QFACALO0
D5321F75475B19¢8E

0.6.2

0.6.2

Apr 30 2015

5110 &.0.0, 0.2

[¥] Autoscrol Nolineending v | (9600baud

To send an AT command to the Bluefruit LE module, enter the command in the textbox
at the top of the Serial Monitor and click the Send button:

ATI Send

The response to the AT command will be displayed in the main part of the Serial
Monitor. The response from 'ATI' is shown below:
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[ JON | /dev/cu.usbmodem1411131
Send

BLE AT COMMAND EXAMPLE
Initialising the Bluefruit LE module: OK!
Performing a factory reset: OK!
BLEFRIEND32

nRF51822 QFACA10
DEB72(43325A171B

0.6.5

0.6.5

Apr 30 2015

5110 8.0.0, 0.2

AT > ATI

BLEFRIEND32

nRF51822 QFACA10Q
DEB72(43325A1718

0.6.5

0.6.5

Apr 30 2015

$110 8.0.0, 0.2

0K

AT >

@ Autoscroll You've pressed Send b... | Nolineending $ = 115200 baud *

You can do pretty much anything at this prompt, with the AT command set. Try AT+HE
LP to get a list of all commands, and try out ones like AT+HWGETDIETEMP (get
temperature at the nRF51822 die) and AT+HWRANDOM (generate a random number)

M - & - ~
COM250 (Adafruit Flora) =
[ send |

-~

[OK
Requesting Bluefruit info:

BLEFRIEND32
nRF51822 QFACALOQ
DS5321F75475B19EE
0.6.2

0.6.2

Rpr 30 2015

5110 8.0.0, 0.2

AT > AT+HWRANDCOM

<- O0xASA3DEF1

> AT+HWGETDIETEMP

25.0

1 m

>

Autoscroll
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BLEUart

The BLEUart example sketch allows you to send and receive text data between the
Arduino and a connected Bluetooth Low Energy Central device on the other end
(such as you mobile phone using the Adafruit Bluefruit LE Connect application for And
roid () or iOS () in UART mode).

Opening the Sketch

To open the ATCommand sketch, click on the File > Examples >
Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and select bleuart_cmdmode:

Adafruit_AHRS >
Adafruit_BluefruitLE_nRF51 > atcommand
Adafruit_BMP085_Unified > beacon
Adafruit_BMP183_Unified_Library > bleuart
Adafruit_BNO055 > factoryreset
Adafruit_CC3100 > heartratemonitor
Adafruit_DHT_Unified > hidkeyboard
Adafruit_DotStar > uribeacon
Adafruit_FONA_Library >

This will open up a new instance of the example in the IDE, as shown below:
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p
blevart_cmdmode | Arduino 1.6.4

File Edit Sketch Tools Help

bleuart_cmdmode §

Bfile bleuart_cmdmode. ino
fauthor hathach, ktown (Adafruit Industries)

This demo will show you how to send and receive data in COMMAND mode 1
(without needing to put the module into DATA mode or using the MODE pin)

*/

#include <string.h>

#include <Arduino.h>

#include <SPI.h>

#include <SoftwareSerial.h>

#include "Adafruit BLE.h"
#include "Adafruit BLE_HWSPI.h"
#include "Adafruit BluefruitLE_UART.h"

// If you are using Software Serial....
// The following macros declare the pins used for 5W serial, you should
// use these pins if you are connecting the UART Friend to |an uno

#define BLUEFRUIT_SWUART RXD_PIN 9 // Required for software serial!
#define BLUEFRUIT_SWUART TXD_PIN 10 // Recuired for software serial!
#define BLUEFRUIT_UART CTS_PIN 11 // Required for software serial!
#define BLUEFRUIT_UART RTS_PIN -1 // Optional, set to -1 if unused

// If you are using Hardware Serial
// The following macros declare the Serial port you are using. Uncomment this

74 Viwmm i€ wemiy mwm mmvemsdisves #lam DIT 4m T mmsmonde /WS saen o~ T aao

<« | m | )

Adafruit Flora on COM250

Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware
UART or Software/Hardware SPI. The default is hardware SPI

If using software or hardware Serial UART:

« This tutorial does not need to use the MODE pin, make sure you have the mode
switch in CMD mode if you do not configure & connect a MODE pin

- Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not
using it! (The Flora has this already done)
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Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and
the upload process has finished, open up the Serial Monitor via Tools > Serial Monitor,
and make sure that the baud rate in the lower right-hand corner is set to 115200:

Once you see the request, use the App to connect to the Bluefruit LE module in UART
mode so you get the text box on your phone

Any text that you type in the box at the top of the Serial Monitor will be sent to the
connected phone, and any data sent from the phone will be displayed in the serial
monitor:
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You can see the incoming string here in the Adafruit Bluefruit LE Connect app below
(iOS in this case):
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The response text ('Why hello, Arduino!') can be seen below:
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HIDKeyboard

The HIDKeyboard example shows you how you can use the built-in HID keyboard AT
commands to send keyboard data to any BLE-enabled Android or iOS phone, or other

device that supports BLE HID peripherals.

Opening the Sketch

To open the ATCommand sketch, click on the File > Examples >
Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and select hidkeyboard:
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This will open up a new instance of the example in the IDE, as shown below:

Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware
UART or Software/Hardware SPI. The default is hardware SPI

If using software or hardware Serial UART:

« This tutorial does not need to use the MODE pin, make sure you have the mode
switch in CMD mode!
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- Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not
using it! (The Flora has this already done)

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and
the upload process has finished, open up the Serial Monitor via Tools > Serial Monitor,
and make sure that the baud rate in the lower right-hand corner is set to 115200:
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To send keyboard data, type anything into the textbox at the top of the Serial Monitor
and click the Send button.
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Bonding the HID Keyboard

Before you can use the HID keyboard, you will need to 'bond' it to your phone or PC.
The bonding process establishes a permanent connection between the two devices,
meaning that as soon as your phone or PC sees the Bluefruit LE module again it will
automatically connect.

The exact procedures for bonding the keyboard will varying from one platform to
another.

When you no longer need a bond, or wish to bond the Bluefruit LE module to

another device, be sure to delete the bonding information on the phone or PC,
otherwise you may not be able to connect on a new device!

Android

To bond the keyboard on a Bluetooth Low Energy enabled Android device, go to
the Settings application and click the Bluetooth icon.

These screenshots are based on Android 5.0 running on a Nexus 7 2013. The

exact appearance may vary depending on your device and OS version.

Inside the Bluetooth setting panel you should see the Bluefruit LE module advertising
itself as Bluefruit Keyboard under the 'Available devices' list:
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Tapping the device will start the bonding process, which should end with the Bluefruit
Keyboard device being moved to a new 'Paired devices' list with 'Connected' written
underneath the device name:

To delete the bonding information, click the gear icon to the right of the device name
and the click the Forget button:
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I0S

To bond the keyboard on an iOS device, go to the Settings application on your phone,
and click the Bluetooth menu item.

The keyboard should appear under the OTHER DEVICES list:

Once the bonding process is complete the device will be moved to the MY DEVICES
category, and you can start to use the Bluefruit LE module as a keyboard:
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To unbond the device, click the 'info' icon and then select the Forget this Device

option in the menu:

OS X

To bond the keyboard on an OS X device, go to the Bluetooth Preferences window
and click the Pair button beside the Bluefruit Keyboard device generated by this
example sketch:

To unbond the device once it has been paired, click the small 'x' icon beside Bluefruit

Keyboard:
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... and then click the Remove button when the confirmation dialogue box pops up:

Controller

The Controller sketch allows you to turn your BLE-enabled iOS or Android device in a
hand-held controller or an external data source, taking advantage of the wealth of
sensors on your phone or tablet.

You can take accelerometer or quaternion data from your phone, and push it out to
your Arduino via BLE, or get the latest GPS co-ordinates for your device without
having to purchase (or power!) any external HW.

Opening the Sketch

To open the Controller sketch, click on the File > Examples >
Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and select controller:
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This will open up a new instance of the example in the IDE, as shown below:

Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware
UART or Software/Hardware SPI. The default is hardware SPI

If using software or hardware Serial UART:

« This tutorial will also be easier to use if you wire up the MODE pin, you can use
any pin but our tutorial has pin 12 by default. You can change this to any pin. If
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you do not set the MODE pin then make sure you have the mode switch in CMD
mode

« If you are using a Flora or otherwise don't want to wire up the Mode pin, set the
BLUEFRUIT_UART_MODE_PIN to -1in the configuration tab so that the sketch
will use the +++ method to switch between Command and Data mode!

- Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not
using it! (The Flora has this already done)

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and
the upload process has finished, open up the Serial Monitor via Tools > Serial Monitor,
and make sure that the baud rate in the lower right-hand corner is set to 115200:

Using Bluefruit LE Connect in Controller
Mode

Once the sketch is running you can open Adafruit's Bluefruit LE Connect application
(available for Android () or iOS ()) and use the Controller application to interact with
the sketch. (If you're new to Bluefruit LE Connect, have a look at our dedicated
Bluefruit LE Connect learning guide ().)
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On the welcome screen, select the Adafruit Bluefruit LE device from the list of BLE
devices in range:

Then from the activity list select Controller:

This will bring up a list of data points you can send from your phone or tablet to your
Bluefruit LE module, by enabling or disabling the appropriate sensor(s).

Streaming Sensor Data

You can take Quaternion (absolute orientation), Accelerometer, Gyroscope,
Magnetometer or GPS Location data from your phone and send it directly to your
Arduino from the Controller activity.

By enabling the Accelerometer field, for example, you should see accelerometer data
update in the app:
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The data is parsed in the example sketch and output to the Serial Monitor as follows:

Accel
Accel
Accel
Accel
Accel

0.20-0.51
0.22-0.50
0.25-0.51
0.21-0.47
0.27-0.48

©Adafruit Industries

-0.76
-0.83
-0.83
-0.76
-0.82
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Note that even though we only print 2 decimal points, the values are received from
the App as a full 4-byte floating point.

Control Pad Module

You can also use the Control Pad Module to capture button presses and releases by
selecting the appropriate menu item:

This will bring up the Control Pad panel, shown below:

Button presses and releases will all be logged to the Serial Monitor with the ID of the
button used:

Button 8 pressed
Button 8 released
Button 3 pressed
Button 3 released

Color Picker Module

You can also send RGB color data via the Color Picker module, which presents the
following color selection dialogue:
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This will give you Hexadecimal color data in the following format:

RGB #A42FFF

You can combine the color picker and controller sample sketches to make color-
configurable animations triggered by buttons in the mobile app-- very handy for
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wearables! Download this combined sample code (configured for Feather but easy to
adapt to FLORA, BLE Micro, etc.) to get started:

feather_bluefruit_neopixel_animation

HeartRateMonitor

The HeartRateMonitor example allows you to define a new GATT Service and
associated GATT Characteristics, and update the characteristic values using standard
AT commands.

Opening the Sketch

To open the ATCommand sketch, click on the File > Examples >
Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and select heartratemonitor:

This will open up a new instance of the example in the IDE, as shown below:
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Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware
UART or Software/Hardware SPI. The default is hardware SPI

If Using Hardware or Software UART

This tutorial does not need to use the MODE pin, make sure you have the mode
switch in CMD mode if you do not configure & connect a MODE pin

This demo uses some long data transfer strings, so we recommend defining and
connecting both CTS and RTS to pins, even if you are using hardware serial.
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If you are using a Flora or just dont want to connect CTS or RTS, set the pin #define's
to -1 and Don't forget to also connect the CTS pin on the Bluefruit to ground! (The
Flora has this already done)

If you are using RTS and CTS, you can remove this line below, which will slow down
the data transmission

// this line is particularly required for Flora, but is a good idea
// anyways for the super long lines ahead!
ble.setInterCharWriteDelay(5); // 5 ms

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and
the upload process has finished, open up the Serial Monitor via Tools > Serial Monitor,
and make sure that the baud rate in the lower right-hand corner is set to 115200:
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If you open up an application on your mobile device or laptop that support the
standard Heart Rate Monitor Service (), you should be able to see the heart rate being
updated in sync with the changes seen in the Serial Monitor:

NRF Toolbox HRM Example

The image below is a screenshot from the free nRF Toolbox () application from Nordic
on Android (also available on i0S ()), showing the incoming Heart Rate Monitor data:
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CoreBluetooth HRM Example

The image below is from a freely available CoreBluetooth sample application () from
Apple showing how to work with Bluetooth Low Energy services and characteristics:
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UriBeacon

The UriBeacon example shows you how to use the built-in UriBeacon AT commands
to configure the Bluefruit LE module as a UriBeacon advertiser, following Google's
Physical Web UriBeacon () specification.

Opening the Sketch

To open the ATCommand sketch, click on the File > Examples >
Adafruit_BluefruitLE_nRF51 folder in the Arduino IDE and select uribeacon:

This will open up a new instance of the example in the IDE, as shown below. You can
edit the URL that the beacon will point to, from the default http://www.adafruit.com or
just upload as is to test

©Adafruit Industries Page 93 of 208


https://github.com/google/uribeacon

Configuration

Check the Configuration! page earlier to set up the sketch for Software/Hardware
UART or Software/Hardware SPI. The default is hardware SPI

If using software or hardware Serial UART:

« This tutorial does not need to use the MODE pin, make sure you have the mode
switch in CMD mode if you do not configure & connect a MODE pin

« Don't forget to also connect the CTS pin on the Bluefruit to ground if you are not
using it! (The Flora has this already done)

Running the Sketch

Once you upload the sketch to your board (via the arrow-shaped upload icon), and
the upload process has finished, open up the Serial Monitor via Tools > Serial Monitor,
and make sure that the baud rate in the lower right-hand corner is set to 115200:
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At this point you can open the Physical Web Application for Android () or for @ 0,
and you should see a link advertising Adafruit's website:

HALP!

When using the Bluefruit Micro or a Bluefruit LE with
Flora/Due/Leonardo/Micro the examples dont run?

We add a special line to setup() to make it so the Arduino will halt until it sees
you've connected over the Serial console. This makes debugging great but makes
it so you cannot run the program disconnected from a computer.
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Solution? Once you are done debugging, remove these two lines from setup()

while (!Serial);
delay(500);

| can't seem to "Find" the Bluefruit LE!

Getting something like this?

For UART/Serial Bluefruits:

« Check you have the MODE switch in CMD and the MODE pin not wired to
anything if it isnt used!

« If you are trying to control the MODE from your micro, make sure you set the
MODE pin in the sketch

« Make sure you have RXI| and TXO wired right! They are often swapped by
accident

« Make sure CTS is tied to GND if you are using hardware serial and not using
CTS

« Check the MODE red LED, is it blinking? If its blinking continuously, you might be
in DFU mode, power cycle the module!

« If you are using Hardware Serial/Software Serial make sure you know which one
and have that set up
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If using SPI Bluefruit:

- Make sure you have all 5 (or 6) wires connected properly.
« If using hardware SPI, you need to make sure you're connected to the hardware
SPI port, which differs depending on the main chipset.

If using Bluefruit Micro:

« Make sure you change the RESET pin to #4 in any Config file. Also be sure you
are using hardware SPI to connect!

AT Commands

The Bluefruit LE modules use a Hayes AT-style command set ()to configure the
device.

The advantage of an AT style command set is that it's easy to use in machine to
machine communication, while still being somewhat user friendly for humans.

Test Command Mode '=?"

'Test' mode is used to check whether or not the specified command exists on the
system or not.

Certain firmware versions or configurations may or may not include a specific
command, and you can determine if the command is present by taking the command
name and appending '=?' to it, as shown below

AT+BLESTARTADV=?

If the command is present, the device will reply with 'OK'. If the command is not
present, the device will reply with 'ERROR".

AT+BLESTARTADV="?
OK\ r\n
AT+MISSINGCMD="?
ERROR\ r\n
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Write Command Mode '=xxx'

'Write' mode is used to assign specific value(s) to the command, such as changing the
radio's transmit power level using the command we used above.

To write a value to the command, simple append an '=' sign to the command followed
by any paramater(s) you wish to write (other than a lone '?' character which will be
interpretted as tet mode):

AT+BLEPOWERLEVEL=-8

If the write was successful, you will generally get an 'OK' response on a new line, as
shown below:

AT+BLEPOWERLEVEL=-8
OK\r\n

If there was a problem with the command (such as an invalid parameter) you will get
an 'ERROR' response on a new line, as shown below:

AT+BLEPOWERLEVEL=3
ERROR\ r\n

Note: This particular error was generated because '3' is not a valid value for the
AT+BLEPOWERLEVEL command. Entering '-4', '0' or '4' would succeed since these
are all valid values for this command.

Execute Mode

'Execute' mode will cause the specific command to 'run', if possible, and will be used
when the command name is entered with no additional parameters.

AT+FACTORYRESET

You might use execute mode to perform a factory reset, for example, by executing the
AT+FACTORYRESET command as follows:

AT+FACTORYRESET
OK\r\n
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NOTE: Many commands that are means to be read will perform the same action
whether they are sent to the command parser in 'execute' or 'read' mode. For
example, the following commands will produce identical results:

AT+BLEGETPOWERLEVEL
-4\r\n
OK\ r\n
AT+BLEGETPOWERLEVEL?
-4\r\n
OK\ r\n

If the command doesn't support execute mode, the response will normally be 'ERROR'
on a new line.

Read Command Mode '?"

'Read' mode is used to read the current value of a command.

Not every command supports read mode, but you generally use this to retrieve
information like the current transmit power level for the radio by appending a '?' to the
command, as shown below:

AT+BLEPOWERLEVEL?

If the command doesn't support read mode or if there was a problem with the
request, you will normally get an 'ERROR' response.

If the command read was successful, you will normally get the read results followed
by 'OK' on a new line, as shown below:

AT+BLEPOWERLEVEL?
-4\r\n
OK\ r\n

Note: For simple commands, 'Read' mode and 'Execute' mode behave identically.

Standard AT

The following standard Hayes/AT commands are available on Bluefruit LE modules:
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AT

Acts as a ping to check if we are in command mode. If we are in command mode, we
should receive the 'OK' response.

Codebase Revision: 0.3.0
Parameters: None

Output: None

AT
0K

ATI

Displays basic information about the Bluefruit module.
Codebase Revision: 0.3.0
Parameters: None

Output: Displays the following values:

- Board Name

« Microcontroller/Radio SoC Name

« Unique Serial Number

« Core Bluefruit Codebase Revision

» Project Firmware Revision

« Firmware Build Date

« Softdevice, Softdevice Version, Bootloader Version (0.5.0+)

ATI

BLEFRIEND
nRF51822 QFAAGOO
FB462DF92A2C8656
0.5.0

0.5.0

Feb 24 2015

5110 7.1.0, 0.0
0K

©Adafruit Industries Page 100 of 208



Updates:

- Version 0.4.7+ of the firmware adds the chip revision after the chip name if it can
be detected (ex. 'nRF51822 QFAAGO0OQ').

« Version 0.5.0+ of the firmware adds a new 7th record containing the softdevice,
softdevice version and bootloader version (ex. 'S110 7.1.0, 0.0").

ATZ

Performs a system reset.
Codebase Revision: 0.3.0
Parameters: None

Output: None

ATZ
OK

ATE

Enables or disables echo of input characters with the AT parser
Codebase Revision: 0.3.0
Parameters: '"1' = enable echo, '0' = disable echo

Output: None

# Disable echo support
ATE=0

0K

#Enable echo support
ATE=1

0K
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bt

Dynamically switches between DATA and COMMAND mode without changing the
physical CMD/UART select switch.

When you are in COMMAND mode, entering '+++\n' or '+++\r\n' will cause the module
to switch to DATA mode, and anything typed into the console will go direct to the
BLUE UART service.

To switch from DATA mode back to COMMAND mode, simply enter '+++\n' or '+++\r\n'
again (be sure to include the new line character!), and a new 'OK' response will be
displayed letting you know that you are back in COMMAND mode (see the two 'OK'
entries in the sample code below).

Codebase Revision: 0.4.7

Parameters: None

Output: None

Note that +++ can also be used on the mobile device to send and receive AT
command on iOS or Android, though this should always be used with care.

See the AT+MODESWITCHEN command to control the availability of the +++
command

ATI

BLEFRIEND
nRF51822 QFAAGOO
B122AAC33F3D2296
0.4.6

0.4.6

Dec 22 2014

0K

+++

0K

0K

General Purpose

The following general purpose commands are available on all Bluefruit LE modules:
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AT+FACTORYRESET

Clears any user config data from non-volatile memory and performs a factory reset
before resetting the Bluefruit module.

Codebase Revision: 0.3.0
Parameters: None

Output: None

AT+FACTORYRESET
0K

As of version 0.5.0+ of the firmware, you can perform a factory reset by holding

the DFU button down for 10s until the blue CONNECTED LED lights up, and then
releasing the button.

AT+DFU

Forces the module into DFU mode, allowing over the air firmware updates using a
dedicated DFU app on iOS or Android.

Codebase Revision: 0.3.0
Parameters: None
Output: None

The AT parser will no longer responsd after the AT+DFU command is entered,

since normal program execution effectively halts and a full system reset is
performed to start the bootloader code

AT+DFU
OK
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AT+HELP

Displays a comma-separated list of all AT parser commands available on the system.
Codebase Version: 0.3.0
Parameters: None

Output: A comma-separated list of all AT parser commands available on the system.

The sample code below may not match future firmware releases and is provided

for illustration purposes only

AT+HELP
AT+FACTORYRESET,AT+DFU,ATZ,ATI,ATE,AT+DBGMEMRD, AT+DBGNVMRD , AT+HWLEDPOLARITY , AT+HWLED, AT+HWGETD
0K

AT+NVMWRITE

Writes data to the 256 byte user non-volatile memory (NVM) region.
Codebase Version: 0.7.0

Parameters:

« offset: The numeric offset for the first byte from the starting position in the user
NVM

- datatype: Which can be one of STRING (1), BYTEARRAY (2) or INTEGER (3)

- data: The data to write to NVM memory (the exact payload format will change
based on the specified datatype).

Output: Nothing

# Write 32768 as an integer starting at byte 16 in user NVM
AT+NVMWRITE=16, INTEGER, 32768
0K
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AT+NVMREAD

Reads data from the 256 byte user non-volatile memory (NVM) region.
Codebase Version: 0.7.0

Parameters:

« offset: The numeric offset for the first byte from the starting position in the user
NVM

« size: The number of bytes to read

- datatype: The type used for the data being read, which is required to properly
parse the data and display it as a response. The value can be one of STRING (1),
BYTEARRAY (2) or INTEGER (3)

Output: The data read back, formatted based on the datatype argument.

# Read an integer back from position 16 in user NVM
AT+NVMREAD=16, 4, INTEGER

32768

0K

AT+MODESWITCHEN

Enables or disables mode switches via the '+++' command on the BLE peripheral of
BLE UART side of the connection.

Codebase Version: 0.71

Parameters:

« location: This can be a string, either 'local' or 'ble' indicating which side should
have the '+++' command enabled or disabled, 'local' being the Bluefruit
peripheral and 'ble' being the phone or tablet.

. state: '0' to disable '+++' mode switches, '1' to enable them.

Output: None

By default, '+++' is enabled locally, and disabled in BLE
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# Disable reomte '+++' mode switches
AT+MODESWITCHEN=ble,0
0K

Hardware

The following commands allow you to interact with the low level HW on the Bluefruit
LE module, such as reading or toggling the GPIO pins, performing an ADC conversion
.etc.:

AT+BAUDRATE

Changes the baud rate used by the HW UART peripheral on the nRF51822. Note that
we do not recommend using higher baudrates than 9600 because the nRF51 UART
can drop characters!

Codebase Revision: 0.7.0

Parameters: Baud rate, which must be one of the following values:

+ 1200

+ 2400

+ 4800

+ 9600

- 14400

+ 19200

+ 28800
+ 38400
+ 57600
+ 76800
+ 115200
+ 230400
+ 250000
+ 460800
+ 921600
+ 1000000

Output: The current baud rate
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# Set the baud rate to 115200
AT+BAUDRATE=115200
0K

# Check the current baud rate
AT+BAUDRATE

115200

0K

AT+tHWADC

Performs an ADC conversion on the specified ADC pin
Codebase Revision: 0.3.0
Parameters: The ADC channel (0..7)

Output: The results of the ADC conversion

AT+HWADC=0
178
0K

AT+HWGETDIETEMP

Gets the temperature in degree celcius of the BLE module's die. This can be used for
debug purposes (higher die temperature generally means higher current
consumption), but does not corresponds to ambient temperature and can not be used
as a replacement for a normal temperature sensor.

Codebase Revision: 0.3.0
Parameters: None

Output: The die temperature in degrees celcius

AT+HWGETDIETEMP
32.25
0K
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AT+HWGPIO

Gets or sets the value of the specified GPIO pin (depending on the pin's mode).
Codebase Revision: 0.3.0
Parameters: The parameters for this command change depending on the pin mode.

OUTPUT MODE: The following comma-separated parameters can be used when
updating a pin that is set as an output:

« Pin numbers
« Pin state, where:

© 0 = clear the pin (logic low/GND)
° 1=set the pin (logic high/VCC)

INPUT MODE: To read the current state of an input pin or a pin that has been
configured as an output, enter the pin number as a single parameter.

Output: The pin state if you are reading an input or checking the state of an input pin
(meaning only 1 parameter is supplied, the pin number), where:

+ 0 means the pin is logic low/GND
« 1 means the pin is logic high/VCC

Trying to set the value of a pin that has not been configured as an output will
produce an 'ERROR' response.

Some pins are reserved for specific functions on Bluefruit modules and can not

be used as GPIO. If you try to make use of a reserved pin number an 'ERROR'

response will be generated.

# Set pin 14 HIGH
AT+HWGPIO=14,1
OK

# Set pin 14 LOW
AT+HWGPIO=14,0
0K

# Read the current state of pin 14
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AT+HWGPIO=14
0
oK

# Try to update a pin that is not set as an output
AT+HWGPIOMODE=14,0
0K

AT+HWGPIO=14,1
ERROR

AT+HWGPIOMODE

This will set the mode for the specified GPIO pin (input, output, etc.).
Codebase Revision: 0.3.0

Parameters: This command one or two values (comma-separated in the case of two
parameters being used):

« The pin number
- The new GPIO mode, where:

° 0 =Input

°o 1= Output

o 2 = Input with pullup enabled

° 3 = Input with pulldown enabled

Output: If a single parameters is passed (the GPIO pin number) the current pin mode
will be returned.

Some pins are reserved for specific functions on Bluefruit modules and can not

be used as GPIO. If you try to make use of a reserved pin number an 'ERROR'
response will be generated.

# Configure pin 14 as an output
AT+HWGPIOMODE=14,0
0K

# Get the current mode for pin 14
AT+HWPGIOMODE=14

0

0K
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AT+HWI2CSCAN

Scans the 12C bus to try to detect any connected I12C devices, and returns the
address of devices that were found during the scan process.

Codebase Revision: 0.3.0
Parameters: None

Output: A comma-separated list of any I12C address that were found while scanning
the valid address range on the 12C bus, or nothing is no devices were found.

# I2C scan with two devices detected
AT+HWI2CSCAN

0x23,0x35

0K

# I2C scan with no devices detected
AT+HWI2CSCAN
0K

AT+HWVBAT

Returns the main power supply voltage level in millivolts
Codebase Revision: 0.3.0
Parameters: None

Output: The VBAT level in millivolts

AT+HWVBAT
3248
oK

AT+HWRANDOM

Generates a random 32-bit number using the HW random number generator on the
nRF51822 (based on white noise).

Codebase Revision: 0.4.7
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Parameters: None

Output: A random 32-bit hexadecimal value (ex. '0x12345678')

AT+HWRANDOM
Ox769ED823
0K

AT+HWMODELED

Allows you to override the default behaviour of the MODE led (which indicates the
operating mode by default).

Codebase Revision: 0.6.6

Parameters: LED operating mode, which can be one of the following values:

« disable or DISABLE or O - Disable the MODE LED entirely to save power

« mode or MODE or 1 - Default behaviour, indicates the current operating mode

« hwuart or HWUART or 2 - Toggles the LED on any activity on the HW UART bus
(TX or RX)

« bleuart or BLEUART or 3 - Toggles the LED on any activity on the BLE UART
Service (TX or RX characteristic)

« spi or SPI or 4 - Toggles the LED on any SPI activity

« manual or MANUAL or 5 - Manually sets the state of the MODE LED via a second
comma-separated parameter, which can be on, off, or toggle.

Output: If run with no parameters, returns an upper-case string representing the
current MODE LED operating mode from the fields above

# Get the curent MODE LED setting
AT+HWMODELED

MODE

0K

# Change the MODE LED to indicate BLE UART activity
AT+HWMODELED=BLEUART
0K

# Manually toggle the MODE LED

AT+HWMODELED=MANUAL , TOGGLE
OoK
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AT+UARTFLOW

Enables or disable hardware flow control (CTS + RTS) on the UART peripheral block of
the nRF51822.

Codebase Revision: 0.7.0

Parameters: HW flow control state, which can be one of:

el
. off
-0
o1

Output: If run with no parameters, returns a number representing whether flow control
is enabled (1) or disabled (0).

# Check the current flow control state
AT+UARTFLOW

1

0K

# Disable HW flow control
AT+UARTFLOW=0ff
0K

Beacon

Adafruit's Bluefruit LE modules currently support the following 'Beacon' technologies:

- Beacon (Apple) via AT+BLEBEACON
- UriBeacon (Google) via AT+BLEURIBEACON (deprecated)
« Eddystone (Google) via AT+EDDYSTONE*

Modules can be configured to act as 'Beacons' using the following commands:

AT+BLEBEACON

Codebase Revision: 0.3.0
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Parameters: The following comma-separated parameters are required to enable

beacon mode:

« Bluetooth Manufacturer ID (uint16_t)
« 128-bit UUID

« Major Value (uint16_t)

« Minor Value (uint16_t)

« RSSI @ 1m (int8_t)

Output: None

# Enable Apple iBeacon emulation

# Manufacturer ID = 0x004C
AT+BLEBEACON=0x004C,01-12-23-34-45-56-67-78-89-9A-AB-BC-CD-DE-EF-
FO,0x0000,0x0000, -59

0K

# Reset to change the advertising data

ATZ

0K

# Enable Nordic Beacon emulation

# Manufacturer ID = 0x0059
AT+BLEBEACON=0x0059,01-12-23-34-45-56-67-78-89-9A-AB-BC-CD-DE-EF-
FO,0x0000,0x0000, -59

0K

# Reset to change the advertising data

ATZ

0K

AT+BLEBEACON will cause the beacon data to be stored in non-volatile config

memory on the Bluefruit LE module, and these values will be persisted across

system resets and power cycles. To remove or clear the beacon data you need

to enter the 'AT+FACTORYRESET' command in command mode.

Entering Nordic Beacon emulation using the sample code above, you can see the

simulated beacon in Nordic's 'Beacon Config' tool below:
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AT+BLEURIBEACON

Converts the specified URI into a UriBeacon () advertising packet, and configures the
module to advertise as a UriBeacon (part of Google's Physical Web () project).

To view the UriBeacon URIs you can use one of the following mobile applications:

« Android 4.3+: Physical Web () on the Google Play Store
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« iOS: Physical Web () in Apple's App Store

Codebase Revision: 0.4.7

Parameters: The URI to encode (ex. http://www.adafruit.com/blog ())

Output: None of a valid URI was entered (length is acceptable, etc.).
AT+BLEURIBEACON=http://www.adafruit.com/blog
0K
# Reset to change the advertising data

ATZ
0K

If the supplied URI is too long you will get the following output:

AT+BLEURIBEACON=http://www.adafruit.com/this/uri/is/too/long
URL is too long
ERROR

If the URI that you are trying to encode is too long, try using a shortening service

like bit.ly, and encode the shortened URI.

UriBeacon should be considered deprecated as a standard, and EddyStone
should be used for any future development. No further development will happen
in the Bluefruit LE firmware around UriBeacon.

Deprecated: AT+tEDDYSTONEENABLE

This command will enable Eddystone () support on the Bluefruit LE module.
Eddystone support must be enabled before the other related commands can be used.

Codebase Revision: 0.6.6
Parameters: 1 or O (1= enable, O = disable)

Output: The current state of Eddystone support if no parameters are provided (1=
enabled, O = disabled)
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This command was removed in firmware 0.7.0 to avoid confusion. Use

AT+EDDYSTONESERVICEEN in 0.7.0 and higher.

# Enable Eddystone support
AT+EDDYSTONEENABLE=1
0K

# Check the current Eddystone status on the module
AT+EDDYSTONEENABLE

1

0K

AT+EDDYSTONEURL

This command will set the URL for the Eddystone-URL () protocol.

Codebase Revision: 0.6.6

Parameters:

« The URL to encode (mandatory)

- An optional second parameter indicates whether to continue advertising the
Eddystone URL even when the peripheral is connected to a central device

« Firmware 0.6.7 added an optional third parameter for the RSSI at O meters value.
This should be measured by the end user by checking the RSSI value on the
receiving device at 1m and then adding 41 to that value (to compensate for the
signal strength loss over 1m), so an RSSI of -62 at 1m would mean that you
should enter -21 as the RSSI at Om. Default value is -18dBm.

Output: Firmware <= 0.6.6: none. With firmware >= 0.6.7 running this command with
no parameters will return the current URL.

# Set the Eddystone URL to adafruit
AT+EDDYSTONEURL=http://www.adafruit.com
0K

# Set the Eddystone URL to adafruit and advertise it even when connected
AT+EDDYSTONEURL=http://www.adafruit.com,1
0K
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AT+EDDYSTONECONFIGEN

This command causes the Bluefruit LE module to enable the Eddystone URL config
service for the specified number of seconds.

This command should be used in combination with the Physical Web application from
Google, available for Android () or iOS (). Run this command then select the 'Edit URL
option from the app to change the destination URL over the air.

Codebase Revision: 0.6.6
Parameters: The number of seconds to advertised the config service UUID

Output: None

# Start advertising the Eddystone config service for 5 minutes (300s)
AT+EDDYSTONECONFIGEN=300
0K

AT+EDDYSTONESERVICEEN

Adds or removes the Eddystone service from the GATT table (requires a reset to take
effect).

Codebase Revision: 0.7.0

Parameters: Whether or not the Eddystone service should be enabled or not, using on
of the following values:

el
. Off
o1
-0

Output: If the command is executed with no parameters it will disable a numeric value
indicating whether the service is enabled (1) or disabled (0).

You must perform a system reset for this command to take effect.
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# Enable Eddystone service
AT+EddyStonServiceEn=on
0K

AT+EddyStonServiceEn=1
0K

# Disable Eddystone service
AT+EddyStonServiceEn=off
0K

AT+EddyStonServiceEn=0
0K

AT+EDDYSTONEBROADCAST

This command can be used to start of stop advertising the Eddystone payload using
the URL stored in non-volatile memory (NVM).

Codebase Revision: 0.7.0

Parameters: Whether or not the payload should be broadcast, using one of the
following values:

el
« Off
o1
.0

Output: If executed with no parameters, the current broadcast state will be displayed
as a numeric value.

# Enable broadcasting current setting of EddyStone (stored previously on nvm)
AT+EddyStoneBroadcast=on
0K

AT+EddyStoneBroadcast=1
0K

# Disable broadcasting current setting of EddyStone (still stored on nvm)
AT+EddyStoneBroadcast=o0ff
0K

AT+EddyStoneBroadcast=0
0K
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BLE Generic

The following general purpose BLE commands are available on Bluefruit LE modules:

AT+BLEPOWERLEVEL

Gets or sets the current transmit power level for the module's radio (higher transmit
power equals better range, lower transmit power equals better battery life).

Codebase Revision: 0.3.0

Parameters: The TX power level (in dBm), which can be one of the following values
(from lowest to higher transmit power):

. -40

Output: The current transmit power level (in dBm)

The updated power level will take effect as soon as the command is entered. If

the device isn't connected to another device, advertising will stop momentarily
and then restart once the new power level has taken effect.

# Get the current TX power level (in dBm)
AT+BLEPOWERLEVEL

0

0K

# Set the TX power level to 4dBm (maximum value)
AT+BLEPOWERLEVEL=4

0K

# Set the TX power level to -12dBm (better battery life)
AT+BLEPOWERLEVEL=-12

0K

# Set the TX power level to an invalid value
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AT+BLEPOWERLEVEL=-3
ERROR

AT+BLEGETADDRTYPE

Gets the address type (for the 48-bit BLE device address).
Normally this will be '"1' (random), which means that the module uses a 48-bit address
that was randomly generated during the manufacturing process and written to the die

by the manufacturer.

Random does not mean that the device address is randomly generated every time,
only that a one-time random number is used.

Codebase Revision: 0.3.0
Parameters: None

Output: The address type, which can be one of the following values:

- O = public
«1=random

AT+BLEGETADDRTYPE
1
0K

AT+BLEGETADDR

Gets the 48-bit BLE device address.
Codebase Revision: 0.3.0
Parameters: None

Output: The 48-bit BLE device address in the following format: 'AA:BB:CC:DD:EE:FF'

AT+BLEGETADDR
E4:C6:C7:31:95:11
(0] ¢
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AT+BLEGETPEERADDR

Gets the 48-bit address of the peer (central) device we are connected to.
Codebase Revision: 0.6.5
Parameters: None

Output: The 48-bit address of the connected central device in hex format. The
command will return ERROR if we are not connected to a central device.

Please note that the address returned by the central device is almost always a
random value that will change over time, and this value should generally not be

trusted. This command is provided for certain edge cases, but is not useful in
most day to day scenarios.

AT+BLEGETPEERADDR
48:B2:26:E6:C1:1D
0K

AT+BLEGETRSSI

Gets the RSSI value (Received Signal Strength Indicator), which can be used to
estimate the reliability of data transmission between two devices (the lower the
number the better).

Codebase Revision: 0.3.0
Parameters: None

Output: The RSSI level (in dBm) if we are connected to a device, otherwise '0'

# Connected to an external device
AT+BLEGETRSSI

-46

0K

# Not connected to an external device
AT+BLEGETRSSI

0

0K
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BLE Services

The following commands allow you to interact with various GATT services present on
Bluefruit LE modules when running in Command Mode.

AT+BLEUARTTX

This command will transmit the specified text message out via the UART Service () whi
le you are running in Command Mode.

Codebase Revision: 0.3.0

Parameters: The message payload to transmit. The payload can be up to 240
characters (since AT command strings are limited to a maximum of 256 bytes total).

Output: This command will produce an ERROR message if you are not connected to a
central device, or if the internal TX FIFO on the Bluefruit LE module is full.

As of firmware release 0.6.2 and higher, AT+BLEUARTTX can accept a limited set
of escape code sequences:

« \r = carriage return
«\n =new line

-\t =tab

- \b = backspace

« \\ = backward slash

As of firmware release 0.6.7 and higher, AT+BLEUARTTX can accept the following
escape code sequence since AT+BLEUARTTX=? has a specific meaning to the AT
parser:

« \? = transmits a single question mark

As of firmware release 0.7.6 and higher, AT+BLEUARTTX can accept the following
escape code sequence:

- \+ = transmit a single '+' character without having to worry about +++ mode
switch combinations
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ESCAPE SEQUENCE NOTE: If you are trying to send escape sequences in code
via something like 'ble.print("...");' please note that you will need to send a double
back-slash for the escape code to arrive as-intended in the AT command. For

example: ble.printIn("AT+BLEUARTTX=Some Test\\r\\n");

You must be connected to another device for this command to execute

# Send a string when connected to another device
AT+BLEUARTTX=THIS IS A TEST
0K

# Send a string when not connected

AT+BLEUARTTX=THIS IS A TEST
ERROR

TX FIFO Buffer Handling

Starting with firmware version 0.6.7, when the TX FIFO buffer is full a 200ms blocking
delay will be used to see if any free space becomes available in the FIFO before
returning ERROR. The exact process is detailed in the flow chart below:

Note: The TX FIFO full check will happen for each GATT transaction (of up to 20

bytes of data each), so large data transfers may have multiple 200ms wait states.

You can use the AT+BLEUARTFIFO=TX () command to check the size of the TX FIFO
before sending data to ensure that you have enough free space available in the
buffer.
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The TX FIFO has the following size, depending on the firmware version used:

- Firmware <=0.6.6: 160 characters wide
« Firmware >=0.6.7: 1024 characters wide

It IS possible with large data transfers that part of the payload can be
transmitted, and the command can still produce an ERROR if the FIFO doesn't
empty in time in the middle of the payload transfer (since data is transmitted in
maximum 20 byte chunks). If you need to ensure reliable data transfer, you

should always check the TX FIFO size before sending data, which you can do
using the AT+BLEUARTFIFO command. If not enough space is available for the
entire payload, add a SW delay until enough space is available. Any single
AT+BLEUARTTX command can fit into the FIFO, but multiple large instances of
this command may cause the FIFO to fill up mid transfer.

AT+BLEUARTTXF

This is a convenience function the serves the same purpose as AT+BLEUARTTX, but
data is immediately sent in a single BLE packet ('F' for force packet). This command
will accept a maximum of 20 characters, which is the limit of what can be send in a
single packet.

Codebase Revision: 0.7.6

Parameters: See AT+BLEUARTTX

Output: See AT+BLEUARTTX

AT+BLEUARTRX

This command will dump the UART service ()'s RX buffer to the display if any data has
been received from from the UART service while running in Command Mode. The
data will be removed from the buffer once it is displayed using this command.

Any characters left in the buffer when switching back to Data Mode will cause the
buffered characters to be displayed as soon as the mode switch is complete (within
the limits of available buffer space, which is 1024 bytes on current black 32KB SRAM
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devices, or 160 bytes for the blue first generation BLEFriend board based on 16KB
SRAM parts).

Codebase Revision: 0.3.0

Parameters: None

Output: The RX buffer's content if any data is available, otherwise nothing.

You can also use the AT+BLEUARTFIFO=RX command to check if any incoming

data is available or not.

# Command results when data is available
AT+BLEUARTRX

Sent from Android

0K

# Command results when no data is available
AT+BLEUARTRX
0K

AT+BLEUARTFIFO

This command will return the free space available in the BLE UART TX and RX FIFOs.
If you are transmitting large chunks of data, you may want to check if you have
enough free space in the TX FIFO before sending, keeping in mind that individual
GATT packets can contain up to 20 user bytes each.

Codebase Revision: 0.6.7

Parameters: Running this command with no parameters will return two comma-
separated values indicating the free space in the TX buffer, following by the RX buffer.
To request a specific buffer, you can execute the command with either a "TX" or "RX"
value (For example: "AT+BLEUARTFIFO=TX").

Output: The free space remaining in the TX and RX FIFO buffer if no parameter is
present, otherwise the free space remaining in the specified FIFO buffer.

AT+BLEUARTFIFO
1024,1024
oK

AT+BLEUARTFIFO=TX

1024
0K
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AT+BLEUARTFIFO=RX
1024
oK

AT+BLEKEYBOARDEN

This command will enable GATT over HID (GoH) keyboard support, which allows you
to emulate a keyboard on supported iOS and Android devices. By default HID
keyboard support is disabled, so you need to set BLEKEYBOARDEN to 1 and then
perform a system reset before the keyboard will be enumerated and appear in the
Bluetooth preferences on your phone, where if can be bonded as a BLE keyboard.

Codebase Revision: 0.5.0

Parameters: 1 or O (1= enable, O = disable)

Output: None

As of firmware version 0.6.6 this command is now an alias for AT+BLEHIDEN

You must perform a system reset (ATZ) before the changes take effect!

Before you can use your HID over GATT keyboard, you will need to bond your
mobile device with the Bluefruit LE module in the Bluetooth preferences panel.

# Enable BLE keyboard support then reset
AT+BLEKEYBOARDEN=1

0K

ATZ

0K

# Disable BLE keyboard support then reset
AT+BLEKEYBOARDEN=0

0K

ATZ

0K

AT+BLEKEYBOARD

Sends text data over the BLE keyboard interface (if it has previously been enabled via
AT+BLEKEYBOARDEN).
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Any valid alpha-numeric character can be sent, and the following escape sequences
are also supported:

« \r - Carriage Return
«\n - Line Feed

- \b - Backspace

+\t - Tab

« \\ - Backslash

As of version 0.6.7 you can also use the following escape code when sending a single
character (AT+BLEKEYBOARD=?' has another meaning for the AT parser):

« \? - Question mark

Codebase Revision: 0.5.0
Parameters: The text string (optionally including escape characters) to transmit

Output: None

# Send a URI with a new line ending to execute in Chrome, etc.
AT+BLEKEYBOARD=http://www.adafruit.com\r\n
0K

# Send a single question mark (special use case, 0.6.7+)

AT+BLEKEYBOARD=\"?
0K

AT+BLEKEYBOARDCODE

Sends a raw hex sequence of USB HID keycodes to the BLE keyboard interface
including key modifiers and up to six alpha-numeric characters.

This command accepts the following string-encoded byte array payload, matching the
way HID over GATT sends keyboard data:

- Byte O: Modifier

- Byte 1: Reserved (should always be 00)

« Bytes 2..7: Hexadecimal value(s) corresponding to the HID keys (if no character
is used you can enter '00' or leave trailing characters empty)
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After a keycode sequence is sent with the AT+BLEKEYBOARDCODE command, you
must send a second AT+BLEKEYBOARDCODE command with at least two 00
characters to indicate the keys were released!

Modifier Values

The modifier byte can have one or more of the following bits set:

« Bit O (Ox01): Left Control

« Bit 1 (0x02): Left Shift

« Bit 2 (Ox04): Left Alt

« Bit 3 (Ox08): Left Window
« Bit 4 (Ox10): Right Control
« Bit 5 (0x20): Right Shift

- Bit 6 (0x40): Right Alt

« Bit 7 (0x80): Right Window

Codebase Revision: 0.5.0

Parameters: A set of hexadecimal values separated by a hyphen ('-'). Note that these
are HID scan code values, not standard ASCII values!

Output: None

HID Keyboard Codes

A list of hexademical-format HID keyboard codes can be found here () (see section 7),
and are listed below for convenience sake:

Ox00Reserved (no event indicated)
0x01Keyboard ErrorRoll0Over
0x02Keyboard POSTFail
0x03Keyboard ErrorUndefined
Ox04Keyboard a and A
0x05Keyboard b and B
Ox06Keyboard c and C
Ox07Keyboard d and D
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Ox08Keyboard e and E
0x09Keyboard f and F
Ox0AKeyboard g and G
Ox0BKeyboard h and H
Ox0CKeyboard i and I
Ox0DKeyboard j and J
Ox0EKeyboard k and K
Ox0FKeyboard 1 and L
0x10Keyboard m and M
Ox11Keyboard n and N
0x12Keyboard o and 0O
0x13Keyboard p and P
0x14Keyboard q and Q
0x15Keyboard r and R
Ox16Keyboard s and S
0x17Keyboard t and T
Ox18Keyboard u and U
0x19Keyboard v and V
Ox1AKeyboard w and W
Ox1BKeyboard x and X
Ox1CKeyboard y and Y
0x1DKeyboard z and Z
Ox1EKeyboard 1 and !
Ox1FKeyboard 2 and @
0x20Keyboard 3 and #
0x21Keyboard 4 and $
0x22Keyboard 5 and %
0x23Keyboard 6 and ©
0x24Keyboard 7 and &amp;
0x25Keyboard 8 and *
0x26Keyboard 9 and (
0x27Keyboard 0 and )

Ox28Keyboard Return (ENTER)
0x29Keyboard ESCAPE
Ox2AKeyboard DELETE (Backspace)
0x2BKeyboard Tab

0x2CKeyboard Spacebar
Ox2DKeyboard - and (underscore)

Ox2EKeyboard = and +
Ox2FKeyboard [ and {
0x30Keyboard ] and }

0x31Keyboard \ and |
0x32Keyboard Non-US # and ~
0x33Keyboard ; and :
0x34Keyboard ' and "
Ox35Keyboard Grave Accent and Tilde
0x36Keyboard, and &lt;
0x37Keyboard . and &gt;
0x38Keyboard / and ?
0x39Keyboard Caps Lock
0x3AKeyboard F1
Ox3BKeyboard F2
0x3CKeyboard F3
0x3DKeyboard F4
Ox3EKeyboard F5
Ox3FKeyboard F6
0x40Keyboard F7
Ox41Keyboard F8
0x42Keyboard F9
0x43Keyboard F10
0x44Keyboard F11
0x45Keyboard F12
Ox46Keyboard PrintScreen
0x47Keyboard Scroll Lock
0x48Keyboard Pause
0x49Keyboard Insert
Ox4AKeyboard Home
0x4BKeyboard PageUp
Ox4CKeyboard Delete Forward
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Ox4DKeyboard
Ox4EKeyboard
Ox4FKeyboard
0x50Keyboard
0x51Keyboard
0x52Keyboard

End
PageDown
RightArrow
LeftArrow
DownArrow
UpArrow

0x53Keypad Num Lock and Clear

0x54Keypad /
Ox55Keypad *
Ox56Keypad
0x57Keypad

+

Ox58Keypad ENTER

0x59Keypad
0x5AKeypad
Ox5BKeypad
0x5CKeypad
Ox5DKeypad
Ox5EKeypad
0x5FKeypad
Ox60Keypad
Ox61Keypad
0x62Keypad
Ox63Keypad .
0x64Keyboard
0x65Keyboard
Ox66Keyboard
Ox67Keypad =
0x68Keyboard
0x69Keyboard
Ox6AKeyboard
Ox6BKeyboard
Ox6CKeyboard
Ox6DKeyboard
Ox6EKeyboard
Ox6FKeyboard
0x70Keyboard
0x71Keyboard
0x72Keyboard
0x73Keyboard
0x74Keyboard
0x75Keyboard
0x76Keyboard
0x77Keyboard
0x78Keyboard
0x79Keyboard
Ox7AKeyboard
Ox7BKeyboard
0x7CKeyboard
Ox7DKeyboard
Ox7EKeyboard
0x7FKeyboard
Ox80Keyboard
0x81Keyboard
0x82Keyboard
0x83Keyboard
0x84Keyboard

Voo ~NOOUTE,WN K

and End

and Down Arrow
and PageDn

and Left Arrow

and Right Arrow
and Home

and Up Arrow
and PageUp

and Insert

and Delete
Non-US \ and |
Application
Power

F13

F14

F15

F16

F17

F18

F19

F20

F21

F22

F23

F24

Execute

Help

Menu

Select

Stop

Again

Undo

Cut

Copy

Paste

Find

Mute

Volume Up

Volume Down
Locking Caps Lock
Locking Num Lock
Locking Scroll Lock

0x85Keypad Comma
0x86Keypad Equal Sign

0x87Keyboard
0x88Keyboard
0x89Keyboard
0x8AKeyboard
Ox8BKeyboard
0x8CKeyboard
0x8DKeyboard
Ox8EKeyboard
Ox8FKeyboard
0x90Keyboard
0x91Keyboard

Internationall
International?2
International3
International4
International5s
International6
International?
International8
International9
LANG1

LANG2
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0x92Keyboard
0x93Keyboard
0x94Keyboard
0x95Keyboard
0x96Keyboard
0x97Keyboard
0x98Keyboard
0x99Keyboard
0x9AKeyboard
Ox9BKeyboard
0x9CKeyboard
0x9DKeyboard
0x9EKeyboard
0x9FKeyboard
OxAOKeyboard
0xAlKeyboard
OxA2Keyboard
OxA3Keyboard
0xA4Keyboard
OxEOKeyboard
OxE1lKeyboard
OxE2Keyboard
OxE3Keyboard
OxE4Keyboard
OxE5Keyboard
OxE6Keyboard
OxE7Keyboard

The following example shows how you can use this command:

# send 'abc' with left shift key (0x02)
AT+BLEKEYBOARDCODE=02-00-04-05-06-00-00

0K

# Indicate that the keys were released (mandatory!)

LANG3

LANG4

LANG5

LANG6

LANG7

LANG8

LANG9
Alternate Erase
SysReq/Attention
Cancel

Clear

Prior

Return
Separator
Out

Oper
Clear/Again
CrSel/Props
ExSel
LeftControl
LeftShift
LeftAlt

Left GUI
RightControl
RightShift
RightAlt
Right GUI

AT+BLEKEYBOARDCODE=00-00

0K

AT+BLEHIDEN

This command will enable GATT over HID (GoH) support, which allows you to emulate

a keyboard, mouse or media controll on supported iOS, Android, OSX and Windows
10 devices. By default HID support is disabled, so you need to set BLEHIDEN to 1 and
then perform a system reset before the HID devices will be enumerated and appear in

on your central device.

Codebase Revision: 0.6.6

Parameters: 1 or O (1 = enable, O = disable)

Output: None
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You normally need to 'bond' the Bluefruit LE peripheral to use the HID
commands, and the exact bonding process will change from one operating
system to another.

If you have previously bonded to a device and need to clear the bond, you can
run the AT+FACTORYRESET command which will erase all stored bond data on
the Bluefruit LE module.

# Enable GATT over HID support on the Bluefruit LE module
AT+BLEHIDEN=1
0K

# Reset so that the changes take effect
ATZ
0K

AT+BLEHIDMOUSEMOVE

Moves the HID mouse or scroll wheen position the specified number of ticks.

All parameters are signed 8-bit values (-128 to +127). Positive values move to the right
or down, and origin is the top left corner.

Codebase Revision: 0.6.6
Parameters: X Ticks (+/-), Y Ticks (+/-), Scroll Wheel (+/-), Pan Wheel (+/-)

Output: None

# Move the mouse 100 ticks right and 100 ticks down
AT+BLEHIDMOUSEMOVE=100,100
0K

# Scroll down 20 pixels or lines (depending on context)
AT+BLEHIDMOUSEMOVE=, , 20,
0K

# Pan (horizontal scroll) to the right (exact behaviour depends on 0S)
AT+BLEHIDMOUSEMOVE=0,0,0,100

AT+BLEHIDMOUSEBUTTON

Manipulates the HID mouse buttons via the specific string(s).
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Codebase Revision: 0.6.6

Parameters: Button Mask String [L][R][M][B][F], Action [PRESS][CLICK][DOUBLECLICK]
[HOLD]

« L = Left Button

+ R = Right Button

- M = Middle Button

- B = Back Button

- F = Forward Button

« If the second parameter (Action) is "HOLD", an optional third parameter can be
passed specifying how long the button should be held in milliseconds.

Output: None

# Double click the left mouse button
AT+BLEHIDMOUSEBUTTON=L,doubleclick
0K

# Press the left mouse button down, move the mouse, then release L
# This is required to perform 'drag' then stop type operations
AT+BLEHIDMOUSEBUTTON=L

OK
AT+BLEHIDMOUSEMOVE=-100,50
0K

AT+BLEHIDMOUSEBUTTON=0

oK

# Hold the backward mouse button for 200 milliseconds (0S dependent)
AT+BLEHIDMOUSEBUTTON=B, hold, 200
0K

AT+BLEHIDCONTROLKEY

Sends HID media control commands for the bonded device (adjust volume, screen
brightness, song selection, etc.).

Codebase Revision: 0.6.6

Parameters: The HID control key to send, followed by an optional delay in ms to hold
the button
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The control key string can be one of the following values:

« System Controls (works on most systems)

° BRIGHTNESS+
°© BRIGHTNESS-

« Media Controls (works on most systems)

o PLAYPAUSE
o MEDIANEXT
o MEDIAPREVIOUS
o MEDIASTOP

« Sound Controls (works on most systems)

° VOLUME
MUTE
BASS
TREBLE
BASS_BOOST
°© VOLUME+
°© VOLUME-
°o BASS+

°© BASS-

o TREBLE+
o TREBLE-

e}

o

o

[e]

« Application Launchers (Windows 10 only so far)

o EMAILREADER
o CALCULATOR
° FILEBROWSER

- Browser/File Explorer Controls (Firefox on Windows/Android only)

o SEARCH
HOME

BACK
FORWARD
STOP
REFRESH
BOOKMARKS

e}

o

o

[e]

[e]

e}

You can also send a raw 16-bit hexadecimal value in the 'OXABCD' format. A full list of
16-bit 'HID Consumer Control Key Codes' can be found here ()(see sec